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SpecsIntact User Guide 

About This User Guide 

The SpecsIntact User Guide is designed to teach SpecsIntact users the concepts involved in 
successfully completing projects by fully utilizing all the tools provided in the SpecsIntact system. 

This User Guide provides a basic introduction to many of the concepts in SpecsIntact. It will assist new 
users by giving them a fundamental understanding of SpecsIntact, but experienced users will also find 
it helpful as refresher material. It’s not intended to give an in-depth explanation of every aspect of 
using SpecsIntact, but it is a good place to begin. 

This User Guide does NOT cover the installation process and assumes that you already have both the 
SpecsIntact software installed and the UFGS Master text loaded on your computer system. 

You are encouraged to use this User Guide in conjunction with the other user tools we provide, like 
the on-screen and searchable Help, eLearning Modules and our other website resources, which are all 
conveniently accessible from the SpecsIntact Help menus and our Support and Help Center website. 

 
How to Use this User Guide 
 
We want learning SpecsIntact to be as painless as possible, so we’ve designed this User Guide to give 
you enough information to get you going successfully without overwhelming you with every possible 
detail. 
 
Along the way, we’ll point out key information that you should remember and call your attention to 
things that you should avoid. 
 
As you review the chapters in this User Guide, please note that before moving on to the next chapter, 
be sure you have a good understanding of the information, since the subsequent chapters will build 
on that knowledge. 
 
Throughout this User Guide, we’ll call your attention to important issues using the symbols noted 
below:  
 

 Tip: Helpful hint that might make your work easier. 

 FAQ: Frequently Asked Question - just that. 
 
 

INTRODUCTION 

https://www.wbdg.org/dod/specsintact/elearning
https://www.wbdg.org/dod/specsintact/support-help-center
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 Note: Important point, so pay attention. 

 Caution: The condition or action may cause problems - proceed at your own risk. 

 Stop: Proceed at your own risk. Stop - means stop - don’t do it or you may regret it 
later! 

 eLearning Video: A portion of the topics covered in this manual are also available 
as short eLearning Videos on our website. 

 
 

What Is SpecsIntact 
 
SpecsIntact (SI) is an automated project management system for processing UFGS Master and other 
local Masters that are used in facility construction projects. SpecsIntact provides built-in quality 
assurance reports and automated functions that lets you adapt standardized facility construction 
specifications to fit your project. It is also a DoD requirement to use SpecsIntact software to produce 
construction specification projects in all three DoD agencies: U.S. Army Corps of Engineers (USACE), 
the U.S. Naval Facilities Engineering Command (NAVFAC) and the U.S. Air Force Civil Engineer Center 
(AFCEC). 
 
SpecsIntact is used worldwide by USACE, NAVFAC and USAF. 
 

 A Brief History of SpecsIntact: 
 

• 1965 - Conceived by NASA 
• 1986 - Adopted by NAVFAC 
• 1988 - Adopted by USACE 
• 2023 - The SI Project transitioned from NASA to USACE. 

 
SpecsIntact makes it possible to assure quality control for project specifications from beginning to 
end. 
 
The SpecsIntact system is managed by the Corps of Engineers Huntsville Engineering and Support 
Center (CEHNC). SpecsIntact is used by engineers, architects, specification writers, project 
managers and construction managers doing business with the three supported government 
agencies: Army, Navy and Air Force. 
  

https://www.wbdg.org/dod/specsintact/elearning
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Using SpecsIntact reduces the time and expense required to produce facility specifications, and helps 
eliminate costly construction changes due to omissions, discrepancies or improper quality controls. 
SpecsIntact utilizes the latest UFGS Master Sections, which are complete, inter-agency guide 
specifications.  
  

  Everything a Project Specifier could possibly need to include in a particular Section or project, 
and that may be required by a particular agency (Army, Navy, or Air Force) is contained in a 
UFGS Master Section. They are called Master Guide Specifications for a reason. Using these 
Masters, you adapt their content to your project by editing them in the SpecsIntact Editor. 
The idea is to pull the applicable Sections for your project into a SpecsIntact Job. After that, 
you can edit the Master Guide Spec Sections as is applicable to your projects’ specific needs 
without affecting the UFGS Master Sections. 

 

  When upgrading the software, SpecsIntact will not delete or modify your existing Jobs or 
Masters. Even if you completely uninstall SpecsIntact, your Jobs and Masters folders will 
remain, and stay intact. Additionally, all the existing Working Directories will also be 
preserved and automatically connected. 
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SpecsIntact and UFGS 
 
The SpecsIntact (SI) Software and the Unified Facilities Guide Specifications (UFGS) work together to 
create an up-to-date and complete guide specification for all types of construction projects. 
 

 The UFGS Master Sections are published only in electronic format and are 
intended to be used with SpecsIntact software. 

 

 It is important to start with the latest UFGS Master Sections so that you have the 
most up-to-date Sections at the start of a new Job. These are released four times 
per year in February, May, August, and November on the 4th Thursday of that 
month. 

  

 For directions on how to install and setup the SpecsIntact software and to obtain 
the latest UFGS Master refer to the Installation Guide on our Support and Help 
Center webpage. 

 
One of the first basics you should know about SpecsIntact is that it is referred to as a system rather 
than just software. It is two software applications working together:  

  
• SpecsIntact (SI) Explorer - Main window used to manage Jobs (projects) 
• SpecsIntact (SI) Editor - Specification Section Editor 

  
SpecsIntact allows you complete control of your projects - choosing the specifications you need from 
the latest standard guide specifications known as the UFGS Master Sections. These Master Section 
specifications are pulled into project specifications and then edited to pertain to a particular project. 
This means a Project Specifier doesn’t have to start from scratch every time they begin a new project. 
 
In SpecsIntact we refer to these projects as Jobs. Once preliminary edits have been made to the 
specification Section in a Job, SpecsIntact has several automated processes and quality control 
reports, which provide checks and balances for those edits. To finish it up, you can choose to produce 
your completed specifications in a choice of three output formats – SpecsIntact specification print 
(.prn) files, PDF, or MS Word.  
  
If you follow the editing rules and use the quality controls and automated features, you can produce a 
final project that is complete and accurate. 
 
 
 

CHAPTER 1: SPECSINTACT 
BASICS 

https://www.wbdg.org/dod/specsintact/support-help-center
https://www.wbdg.org/dod/specsintact/support-help-center
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UFGS Master Specification Reference Documents 
 
There are two main reference documents that the UFGS Master Sections conform to: 
 

1. CSI MasterFormat Section List: Contact your designated agency Dataset Manager for 
information on licensing for this manual: https://www.csiresources.org/home. All UFGS 
Master Section Numbers and Titles follow the CSI MasterFormat rules, so please refer to those 
rules when numbering and titling a new Section, or re-numbering an existing Section. 
 

2. Refer to the Unified Facilities Supplement (UFS)  UFS 1-300-02 document which is the 
standard used for all Section formatting guidance for the preparation of Unified Facilities 
Guide Specifications (UFGS) Master Specifications. 
 

 
SpecsIntact Terms 
 
If you’re new to SpecsIntact, you may find some terms unfamiliar. Learning what they mean will help 
you understand how the system works and how to communicate more effectively regarding your 
project. 
 
Some terms you’ll encounter are somewhat unique to SpecsIntact (e.g., Jobs (aka Projects), Masters, 
Sections, Tags, Working Directories, Reconciliation, Subparts (aka Articles/Paragraphs), Tailoring, etc.)  
Other terms are industry-related and may already be familiar to you (e.g., Submittals, References, 
Reports), while still others are computer-related. Since SpecsIntact users come from a variety of 
backgrounds, we’ll define terms for you as we go along. 
 

https://www.csiresources.org/home
https://www.wbdg.org/dod/ufc/ufc-1-300-02
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You’ll also discover that some common words have very specific meanings in SpecsIntact. For 
example, while working in a Microsoft Word document, you might say that you’re having trouble with 
a Section, referring to a portion of the document. 
However, when working in SpecsIntact, a Section refers 
to the entire document, while its content is composed 
of Parts and Subparts.  
 
SpecsIntact utilizes specification Sections contained in 
the Unified Facilities Guide Specifications (UFGS) Master 
database. This is where the term Master comes from. 
The UFGS Master is comprised of forty-eight (48) 
Divisions that group the Sections based on their content. 
You can identify which Division a Section belongs to by 
looking at the first two numbers in the Section Name. 
For example, Section 21 12 00 Standpipe Systems comes 
from Division 21 Fire Suppression. 
 
 

 To learn more about SpecsIntact terminology, refer to the Terminology topic in the Web-Based 
Help. 

 
 
SpecsIntact Tagging - Foundation for Processes and Reports 
 
SpecsIntact uses a special tagging system like the HTML code that tells a web browser how to display 
a web page. SpecsIntact uses these applicable tags to identify what a Reference (RID), Submittal 
(SUB), Section Reference (SRF), Tailoring Option (TAI), etc. components are. This is also how the 
SpecsIntact Verification reports and Reconciliation processes can run and verify the accuracy of these 
components, requirements and processes. This helps reduce the time spent manually QA’ing and 
completing your project. 
 

 To learn more about SpecsIntact tags, refer to the SpecsIntact Tags topic in the Web-Based 
Help. 

 
Correct tagging of these components is critically important. The tagging and Section structure is 
discussed in more detail later in this User Guide. As shown above, some of the most important 
component tags are also color-coded (including the text inside them). This makes them easy to 
identify even when you are not viewing or printing the Section with tags showing. 

https://www.wbdg.org/tools/specsintact/Help/#t=SIGeneral%2FSpecsIntactTerminology.htm
https://www.wbdg.org/tools/specsintact/Help/#t=SITags%2FSpecsIntactTags.htm
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SpecsIntact System 
 
It’s important to understand the normal workflow when creating, editing and processing a SpecsIntact 
Job, starting with understanding that there are two main component programs of the SpecsIntact 
system: The SI Explorer and the SI Editor. 
 
 
SI Explorer 
 
It is through the SI Explorer that you accomplish all the project management functions, from putting 
together the specifications Sections you need for your project, creating a Job, running the reports, and 
producing the final product. It provides a way to visually manage the entire project, or multiple 
projects at the same time. 
 

 
 
Two common features in SpecsIntact that work in the SI Explorer window are drag-and-drop and 
right-clicking. For example: 
 

1. In the SI Explorer, you can add Sections to your Job by dragging them from either the Windows 
File Explorer, a Master, an Email or from another Job then dropping them in the destination 
Job folder. This also works in reverse, as you can drag-and-drop them from a Job or Master 
into an Email, a Windows File Explorer folder, etc. 

 
2. To access common commands in SI Explorer, simply right-click on a Job or Master name, or a 

Section, and select options from the resulting pop-up menu. 
 
We will explain more of the SI Explorer functions and how to use them later in this User Guide as we 
review how to navigate this system in more detail. 
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 For additional guidance, watch the eLearning modules within Chapter 2 - Creating a Job and 
Adding Sections and Chapter 8 - Additional Tools and Techniques. 

 
 
SpecsIntact Folders and Files 
 
You’ll see two main types of folders displayed in the SI Explorer: Jobs and Masters. 
 

  Jobs are created under the Jobs folder, while any connected Masters 
are located under the Masters folder. When you create a Job, you will 
essentially be copying specification Sections from a Master (usually the 
UFGS Master) into your created Job. 

 
 
The type of files you edit in SpecsIntact are called Sections — when you see them on your computer 
system, they have a file extension of (.sec). UFGS Master Sections are formatted with the tagging 
scheme necessary for SpecsIntact’s automated features to work. However, you must edit the content 
of each Section to fit your specific project. 
 
You can set up the contents of some default categories in the Properties for Job window then choose 
which of those categories to display as Column Headers in the Contents panel. 
 
At the start, Section files are the only type your new project will contain, but as you work, you will 
produce other types, such as reports and output files that will reside in applicable subfolders under 
your Job folder. The Section (.sec) files are always the editing copy from which the others are 
produced. 
 

 The only file type that is ever edited in SpecsIntact is the Section (.sec) file.  
 
 
Working Directories and Connect Masters 
 
There are two menu items available from the SI Explorer Setup menu that control which Masters and 
Jobs are connected/displayed in the left pane of the SI Explorer. 

 
Use the Working Directories button to choose the folder location(s) of the Jobs you 
want to be visible. 
 

 

https://www.wbdg.org/dod/specsintact/elearning
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Use the Connect Masters button to choose the folder location(s) of the available 
Masters you want to be visible. 
 

These two options can be used at any time to change the Working Directory folders that contain your 
Jobs and Masters. 
 

  You can only view the Jobs or Masters if the folders they are located in are connected in the 
Working Directories window. 

 

 
 

 For additional guidance, watch the eLearning modules within Chapter 1 - Getting Started. 
 
 
SI Editor 
 
The SI Editor is where you edit your specification Sections. Although it is much more than a word 
processor, it does have many of the same standard features which you are probably already familiar 
with. In addition, it has specialized toolbars and features to help you work more quickly, and 
accurately (especially using those all-important tags we mentioned earlier). The SI Editor is opened by 
default when you select a Section to edit in the SI Explorer. 
 

https://www.wbdg.org/dod/specsintact/elearning
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 The only file type that is ever edited in SpecsIntact is the Section (.sec) file. 
 

 Additional information and instructions on editing sections within the SI Editor can be 
found in the Proper Editing Practices in the SI Editor topic in this guide. This topic 
covers the SI Editor’s most essential functions and features. 
 

 For additional guidance, watch the eLearning modules within Chapter 3 - Editing. 
 

 
Print/Publish (Output) Files 
 

Printing in SpecsIntact is done in the SI Explorer window via the Print/Publish  button. You can 
print selected Sections or all Sections in a Job or Master. 
 
When you process and print a Job, you produce print versions of the Section (.sec) files which become 
the Processed (.prn) files. The print versions of the Sections are generated per your preferences at 
time of printing (e.g., with or without Tags, with or without Notes, etc.), leaving the Section (.sec) files 
completely intact per your edits. After you have run the Print/Publish processes, the Processed (.prn) 
files are then displayed in the Available Projects panel on the left side of the SI Explorer in the 
Processed Files folder under the Job name. Just like the Jobs folder, clicking a subfolder displays its 
contents in the Contents panel on the right. If you need to make further edits, you must always edit 
the Section (.sec) file (directly under the Job name folder), not the (.prn) files or (.rpt) files in the 
Processed Files folder. When you process your Sections again, any new processed files will replace any 
previous Processed (.prn) and/or Report (.rpt) files. 
 

https://www.wbdg.org/dod/specsintact/elearning
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Publish to PDF or Word 
 
You can also produce processed files in two other popular formats: PDF and Microsoft Word. To 
publish Sections to Word, you must have MS Word installed on your system. The SpecsIntact PDF 
Printer is available and recommended to be installed during the SpecsIntact installation process to 
utilize the best PDF publishing options. The generated Word or PDF files are placed in the SI Explorer, 
under that Job Name under their applicable subfolder. 
 

 
 

 
 

  Once I’ve processed and printed to Word, can I edit my Sections in Word? Only for markup 
purposes, as the edits made in the Word document will need to be handed back to someone to 
incorporate the noted changes in the SpecsIntact Section files. 
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  The Word and PDF output files cannot be returned to or edited in SpecsIntact. These formats 
will not contain any of the SpecsIntact tagging or quality controls and are truly only used for 
producing a final copy of your specifications in these alternate formats. 

 

 Additional information on publishing to PDF and Word can be found in their respective 
topics under the Print Processing Window and Option Tabs topic in this guide. 

 

 For additional guidance, watch the eLearning modules within Chapter 4 - Process and 
Print/Publish. 

 
 

Pre-Job Checklist and Guidance Notes 
 
Some very costly mistakes are rooted in a failure to communicate, especially when starting a new 
project. If you are responsible for starting a new Job and editing the specifications, you need to be 
able to ask the right questions at the outset. This page contains a list of suggestions and questions 
offered to get you started on the right foot. 
 

1. Make certain you are using the most recent UFGS Master specifications at the start of the Job. 
 

 To check that you have the latest UFGS Master, open the SI Explorer and select the Help 
menu at the top of the window (not the big Help button) and select Check Current UFGS 
Version. 

 
2. Print the UFGS Master Table of Contents with Scope to PDF from the Print/Publish button on 

the Reports tab. Then forward the file (SCOPE.PDF) to the engineer on the project so they can 
decide which Sections they would like to include in their Job. 

 

 After printing the Table of Contents with scope file (SCOPE.PDF), you can find it in the SI 
Explorer under the Masters > UFGS > PDF Files folder. 

 
3. Based on this UFGS Master Table of Contents, the engineer should then give you a list of 

Sections to be included in the Job so you can then create the new Job and add those Sections 
to it. 
 

4. UFGS Master Section 01 33 00 Submittal Procedures and 01 42 00 Sources for Reference 
Publications are both required to be included in all Jobs, so be sure to add them to the project 
even if the engineer neglects to include them. 

 

https://www.wbdg.org/dod/specsintact/elearning
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  Since they are required, UFGS Master Sections 01 33 00 and 01 42 00 are both added by 
default in the Add Sections window when creating a new Job. 

 
 
Pre-Printing, Markup and Editing Considerations and Questions 
 
At this point, you should have already created the Job with the Sections selected by the engineer. 
However, you now need to ask the engineer some questions and get some pre-editing information 
before printing the Sections for markup. 
 

1. Run the Export Tailoring for Job function to produce the Tailoring Options list in one of the 
available file formats (web, spreadsheet, or comma-delimited). This export file contains a list of 
all the Tailoring Options in every Section of the Job. Once this list is produced, send it to the 
engineer to pre-edit the list prior to sending the Section files out for markup. 

 

 To generate the Tailoring Option file, right-click on the Job name, select Export Tailoring 
for Job and select one or more file formats to export the Tailoring Option list to. Once 
exported, the exported file(s) will appear in the Exported Files folder under the Job name 
(e.g., TailoringOptionData.xlsx). 

 

  This is important so you can remove/hide all the unwanted Tailoring Options from the 
Sections files in the Job before you print them for markup and editing. This is a very helpful 
and time-saving tool, as it provides less information (text) for the engineer and the person 
editing the Sections to have to review. 

 
a. Once you receive the marked up Tailoring Option report back from the engineer, right-

click on the Job and select Tailor Job. When the Tailoring Options window appears, 
uncheck the Tailoring Options to be removed/hidden from the Job Sections. Click OK 
to remove the unchecked Tailoring Options. 

 

  Additional information on Tailoring Options can be found in the Tailoring Option Tags topic 
in this guide. 

 

 For additional guidance, watch the Export Tailoring Options List eLearning module within 
Chapter 8 - Additional Tools and Techniques. 

 
2. Determine if English, Metric or Both units of measure will be used for this Job. 

 

https://www.wbdg.org/dod/specsintact/elearning
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 Both units of measurement are not recommended to be used in a Job, as they are not 
always an exact match and can sometimes cause confusion during a project. 

 
 
Print Recommendations for Sections Prior to First Markups 
 
After completion of pre-tailoring edits and determining which units of measure will be used, there are 
additional important options that need to be considered when printing Sections for the first round of 
markups. 
 

1. Click on the Job name. Then, click on the Print/Publish  button in the SI Explorer. Next, 
you’ll be selecting the following reports and options to be applied to your published Sections: 

 
a. On the Sections tab, select All Sections (if not already selected by default). 

 
b. On the Reports tab, place a check next to the following options: 

 
• Under Reports, select Submittal Register. 
• Under Project Table of Contents, select Include without scope. 
• Under Section Table of Contents, select Include without scope. 

 
c. On the Options tab, under Show, place a check next to the following options: 

 
• Section Dates 
• Notes 

 

  Printing with the Specifier Notes prior to the first round of markups is highly 
recommended as each UFGS Section provides important information and guidance for 
the specifier as they mark up the Section (e.g., the Specifier Note above every ‘1.X 
SUBMITTALS’ Subpart provides guidance on how to mark up the Submittals as it 
pertains to the agency you are processing the specification project for). 

 
• Color (when using color printer) 
• Tailoring tags (when hiding tags) 
• Units of measure for the project 
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d. On the Header/Footer tab, it is recommended to put some identifying text in the header 
(e.g., Original Job Sections for Markup, First Markup Sections, etc.) or whatever you deem 
appropriate to identify these Sections as your original Sections, along with the date. 
 

 
 

e. For best results, it is preferred for you to use the SpecsIntact PDF as your printer. Even 
when publishing to Word, SpecsIntact first publishes to PDF, then converts those PDF files 
to Word files. 
 

f. Print all Job Sections with the selected options by clicking on the green Process & Publish 
 button to generate the applicable files. 

 
g. Once all the necessary files are generated, send the published PDF 

or Word files to the architects or engineers to begin initial redlined 
markups. These files will be located under the appropriate subfolder 
under the Job name. Also send the Project Table of Contents 
(PROJECT.PDF) and the Submittal Register (REGISTER.PDF) for the 
project. 
 

 

 
 

  The Project Table of Contents and the Submittal Register reports can only be produced in PDF 
format, not Word. 

 

 If you prefer to zip all the PDF or Word file Job Sections in one file, instead of dragging and 
dropping them all as separate files into an email, you can easily right-click on the PDF Files folder 
or Word Files folder, then select Open in Windows Explorer. This will quickly jump you right into 
that folder in the Windows File Explorer so you can select the files and zip them up. 

 

  Additional information on all the available print options can be found under the Print Processing 
Window and Option Tabs topic in this guide. 

 

For additional guidance, watch the eLearning modules within Chapter 4 - Process and 
Print/Publish. 

 

https://www.wbdg.org/dod/specsintact/elearning
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Pre-Editing Questions 
 
Before you begin to incorporate any edits into the Job Sections in SpecsIntact, there are some 
additional considerations and questions the engineer/specifier should address before you begin 
editing: 
 

1. Is it required that you track the changes as you are editing? If so, the SI Editor provides the Use 
Revisions function in the SI Editor for this task which is explained in detail under that topic in 
this User Guide. This is similar to the ‘Track Changes’ function in Microsoft Word. 
 

2. Would you like to pre-edit the Job Sections based on the included ‘Tailoring Options’ 
document in all the UFGS Sections? If so, see the Using Tailoring Options to Pre-Edit a Job topic 
in this User Guide for guidance on how to provide this comprehensive list to the specifier. 
 

3. Which unit of measure is being used in this new Job/project? English or Metric? You can select 
the applicable one in the Job Properties window. The default for new Jobs is English, so you 
will not have to worry about changing it unless Metric units will be used. NOTE: There is an 
option to select both English and Metric, however, this is not a recommended option, as the 
conversion from one to the other is not exact. 

  



 
 

17     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

SpecsIntact Workflow - Creating and Publishing a Job 
 
Now that you have some basic understanding of the information needed for your Job, you can 
proceed with creating and publishing it. Below steps you through the basic life cycle of a SpecsIntact 
Job, beginning with creating a new Job and ending with publishing it. 
 
As with most computer programs, there are multiple ways to perform many of the common tasks. This 
illustration shows one path, outlining the steps involved in using the SpecsIntact system. 
 
 
Start 

 
 
 

 
 
 

   

Open the SI Explorer. 
 
Click the New Job button on the 
Toolbar. 

 

 
 
 
 
 
 
 
 
 
 
 
 

  
 

The Create New Job window 
opens. 
 
Fill in the Job name and Title 
fields as applicable. Click OK. 

  Additional information for filling out the Job fields here can be found under the Properties for Job 
Window topic in this guide. 

CHAPTER 2: JOB CREATION 
AND WORKFLOW 
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The Add Sections 
window opens. 
 
Check the Sections 
you need and click 
the green Add button 
to add them to the 
Contents of Job pane 
below, then click OK 
at the bottom to add 
the Sections to your 
Job. 

 

  Additional information on adding Sections can be found under the Adding Sections to a Job topic in 
this guide. 
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The Tailor Sections in Job window opens 
as soon as Sections are added to the Job. 
This window shows all the Tailoring 
Options contained in all the Sections of 
the newly created Job. From here, you 
can globally choose to keep or remove 
specific Tailoring Options for the entire 
project. To remove/hide an option, 
uncheck the box beside it. 
 
Once your selections are complete, click 
OK to apply them, or click Cancel to skip 
for now. 
 
 

  Additional information on Tailoring Options can be found under the Tailoring Option Tags topic in 
this guide. 

 

 
 
 
 

 
 

 Use the SI Explorer to open a Section for editing in the SI Editor by double-clicking on a section. 



 
 

20     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

  

 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

SI Editor 
 
All edits are 
made to the 
Sections in the 
SI Editor. 
 
Save and exit to 
return to the 
SI Explorer. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 
 

Use the 
Print/Publish 
option in the SI 
Explorer to 
generate PDF, 
Word or Print 
SpecsIntact 
Sections and 
Verification 
Reports. 

 

  Additional information on all reports can be found under the Print Processing – Reports Tab topic 
in this guide. 
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Finish 

SI Reports 
 

SpecsIntact 
reports will point 
out any 
discrepancies in 
the References, 
Submittals, etc. 
in your Sections. 
 
Run these 
frequently so you 
can correct 
issues as you go. 

Here is a summarized list of the SpecsIntact workflow steps outlined above: 
 

1. Open the SI Explorer to create a new Job. 
2. Click the New Job button on the Toolbar. 
3. Fill in the Job name and Title fields as applicable. Click OK. 
4. The Add Sections window opens for you to select Sections to add to your Job. 
5. The Tailor Sections in Job window opens. 

a. To remove/hide an option, uncheck the box beside it. Once finished, click OK to apply 
them, or click Cancel to skip this for now. 

6. Use the SI Explorer to open a Section for editing in the SI Editor. 
7. Edit all your Sections in the SI Editor. 

a. Remember to save and exit after finishing Section edits to return to the SI Explorer to 
select the next Section to edit. Repeat with each Section. 

8. Use the Print/Publish option to process and print your edited Job Sections. 
a. You can generate PDF or Word versions of your Sections or print SpecsIntact Sections 

and Job Verification Reports. 
9. Review Reports and correct any errors or discrepancies noted on each report. 

 

 For additional guidance, watch the eLearning modules within Chapter 2 - Creating a Job and 
Adding Sections, Chapter 4 - Process and Print/Publish, and Chapter 6 - Correcting QA Report 
Errors and Discrepancies.  

https://www.wbdg.org/dod/specsintact/elearning
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Job Creation - Additional Details 
 
While the previous topic showed you the quick basics you need to create and then publish your Job, 
this topic will cover some additional details that will be helpful in the Job creation phase. 
 
 
Adding Sections to a Job 
 
Once you fill out the required Job name and Title fields in the Create New Job window and click OK, 
the Add Sections window opens next (as was shown in the SpecsIntact Workflow topic above). 
However, there is some additional information that is helpful to know about adding Sections to your 
Job. 
 

  After your Job has been created, you can click on your Job name and easily add additional 
Sections by clicking on the Add Sections icon at the top of the SI Explorer window. 

 
 

Add Sections Window 
 
From the Add Sections window, you have the following source options for adding Sections to your 
Job: 
 

1. Masters: To add Sections to your Job from a Master, you must select them from the applicable 
Master in the Add Sections window. The default Master is usually the UFGS Master, although 
you may also have a local Master on your system that contains local Sections you may also 
want to add. 
  

    A good way to manage any Sections that you need to create and use in your projects is to 
maintain them in a local Master. A local Master contains Sections that are specific to a 
District, Region, or AE Firm that contains unique Sections not found in the UFGS Master. 

 

  For additional guidance, watch the eLearning modules within Chapter 2 – Creating a Job and 
Adding Sections. 

 
If you have a local Master available, it should show up in your Add Sections window as well as the 
UFGS Master. See example below: 

https://www.wbdg.org/dod/specsintact/elearning
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 Undo Add: If you inadvertently selected a Section that you did not mean to add, you can 
right-click on it in the Contents of Job panel and select Undo Add. Note that this only 
works if you haven’t yet clicked OK to formally add it to your Job. 

 

  Remember that as you are checking Sections to be added to your current Job, you must 
click on the green Add button which initially adds them to the Contents of Job pane in the 
Add Sections window. To add the selected Sections to your Job, you must click OK at the 
bottom of the Add Sections window. 

 
2. Jobs: To add Sections from another Job, select Jobs tab, and all the connected Jobs on your 

system will appear for you to select and add Sections from. 
 

3. Templates: To create a new Section and add it to your Job, select Templates tab. From here, 
select the template source you prefer to use (usually any available UFGS Section template), 
then enter the applicable new Section Number and Title in the provided fields. Once this 
information is entered, click the green Add button to add it to the Sections list in the Contents 
of Job pane. Click OK to add the new template Section to the Job. 
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 Given the complex tagging structure of SpecsIntact Sections, instead of creating a 
template Section, it may be easier to start with a similar Section from either the 
UFGS Master or your local Master. Add this chosen Section to your Job then you 
can rename it and edit it accordingly. 
 

 You must use the SpecsIntact Rename option to rename a Section. For these 
instructions, refer to the SI Explorer Sections Menu - Rename Help topic. 

 
4. Browse button: This button is located at the bottom of the Add Sections window. It allows you 

to browse to any folder in Windows File Explorer to add other Sections into the Job. 
 
 
Drag and Drop Sections into a Job 
 
Once a Job is created, you can also add Sections to it by dragging and dropping Sections within 
SpecsIntact from one Job or Master to another. Additionally, you can also add Sections to your Job by 
dragging them from an external source, such as a Windows File Explorer folder, and dropping them 
into your Job or Master folder. 
 
 SpecsIntact will confirm the insertion of a Section from either method with a pop-up message: 
 

 
 

  Can I add a Section I received in an email to my Job?  While you cannot drag and drop a 
Section directly from an email, you can save the attachment to your computer and then drag 
and drop it from the Windows File Explorer folder into your Job as noted above. 

https://www.wbdg.org/tools/specsintact/Help/#t=SIExplorer%2FExplorer_SectionsMenu_Rename.htm
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 For additional guidance, watch the eLearning modules within Chapter 2 – Creating a Job and 
Adding Sections. 

 
 

Managing Your Job 
 
Once a new Job (project) is created, there are many ways to manage it and keep track of Job specific 
information. You can set up the contents of some default categories in the Properties for Job window 
and then choose which of those categories you want to display as Column Headers in the Jobs 
Contents panel. See an example of these column categories highlighted below.  
 

 
 
To manage which columns are displayed, right-click on any existing column header and select Column 
option. Available columns for Jobs include the following: Title, Section Date, Date Modified, 
Preparing Activity, Specifier, Type, Division, Last Edited By and Summary. All this information is 
located on the applicable tab in the Properties for Job window which is discussed in more detail 
below. 
 
 
Properties for Job Window 
 

To access the Properties for Job window, select the Job name then click the Properties  button. 
In addition to the General tab this window opens to by default, there are five additional tabbed 
options (categories) available for use in tracking everything to do with this Job: Specifiers, Options, 
Schedule, Cover Page and Comments. 
 

1. General: The General tab contains important information about the Job. The only required 
fields in this window are the Job name and Title. 

 

https://www.wbdg.org/dod/specsintact/elearning
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 All the text entry fields on the General tab are available as Header and Footer 
variable options in the Header/Footer tab of the Print Processing window for the 
Job (e.g., Job name, Title, Contract number, Location, Lead specifier and Source). 
This means any content entered in these fields can be automatically selected to be 
inserted in the Header or Footer of the printed or published specification Sections. 

 

  Additional information about the header and footer variables on the Properties for Job 
window can be found under the Print Processing – Header/Footer Tab topic in this guide. 

 
2. Specifiers: The Specifiers tab is used to assign Specifiers to the Divisions they are responsible 

for editing at the Job level. All Sections added to the Job are then automatically assigned the 
appropriate Designer for that Division. NOTE: No fields are required on this tab. 
 

3. Options: The Options tab is used to set up some Job specific options that will determine how 
your Job is viewed and processed. For instance, will English or Metric units be used, will you be 
using Revisions (tracking changes) and what Paragraph Format (Numeric or Alphanumeric) 
will be used for the project? 
 

 By default, English and Use Revisions are selected. Also, MasterFormat 2010 is the 
latest version, and the Paragraph Format is set to Numeric as all government Jobs 
use the Numeric numbering scheme. 

 
4. Schedule: The Schedule tab was designed to track the progression and timeline of your Job by 

capturing the Review Status /Amendment Level and due dates. In addition, it provides a 
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spreadsheet like format to track the Job Cycle which includes columns for the Operator, 
Percent level, Date Received/Due/Delivered, as well as Hours spent. If maintained properly, 
this information can be used to provide updates during scheduled project status meetings. 
NOTE: No fields are required on this tab. 
 

 The Review Status / Amendment Level you create or choose in the Schedule tab 
can also be selected in the PDF Publish tab of the Print Processing window. This 
allows you to save copies of the Job PDF files in their own subfolder per 
Amendment/Submittal phase. 

 
5. Cover Page: On the Cover Page tab, you can add a cover page to a Job either by creating a new 

cover page or by adding one provided by a government agency. You can select an existing 
cover page from the drop-down list. If no cover pages already exist, the only option is No 
Cover Page. There are also options to browse to an existing cover page or create a new cover 
page. NOTE: No fields are required on this tab. 
 

6. Comments: The Comments tab provides an area to record your notations about the Job. 
Entries are user-specific, and date-time stamped, with each new entry appearing at the top of 
the text box (e.g., ‘J. Doe:  6/19/2025 3:06 PM - Updated Section 06 61 16 with redlined 
changes for 35% Submittal.’). NOTE: No fields are required on this tab. 

 

  Some of the Print Processing information noted above in the General and Schedule tabs 
will be revisited in more detail later in this User Guide. 

 
 
Using Tailoring Options to Pre-Edit a Job 

Previously it was recommended that as soon as you create a new Job you should export the Tailoring 
Options for the whole Job and have the specifier mark it up to indicate which Tailoring Options will not 
be needed for the project. You can use that information to pre-edit the Job at the beginning. 

  Additional information on Tailoring Options can be found under the Pre-Printing, Markup and 
Editing Considerations and Questions topic in this guide. 

Tailoring Options make specification editing easier by providing a way to include or exclude blocks of 
information that have been enclosed in Tailoring tags by the UFGS Master specification writers. 
Tailoring Options can be agency specific as well as product or method specific, allowing a project 
specifier to turn off/pre-edit the options they don’t want to include in their project before they even 
begin to mark up the Section(s). These can be applied throughout the entire Job, or in selected 
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Sections, without opening any of the Sections in the SI Editor. This eliminates the need to manually 
edit this information out of each Section. 

Tailoring is displayed by default after you finish adding all the Sections in the Add Sections window 
when creating a new Job or Master. For instance, when processing an Army project, all NAVFAC, 
NAVY and/or AIR FORCE related Tailoring Options can be removed from the project before the first 
Section is even marked up. In this scenario, the following NAVFAC and NAVY specific Tailoring Options 
would be removed during the pre-editing/tailoring of all the Job Sections for the current project. See 
the example below of just one Section that contains multiple Tailoring Options for both ARMY and 
NAVY. Unchecking the Tailoring Options the project specifier does not want to include removes any 
text that is contained within those applicable Tailoring (TAI) tags in the selected Section of the Job. 
 
You can tailor an individual Section by right-clicking on it from the Job or Master Contents pane and 
selecting the Tailor menu option. 
 

 
 
NOTE: The number in the parenthesis beside each Tailoring Option indicates how many times that 
particular Tailoring Option appears in the Section. From here, you can globally choose to keep or 
remove a particular Tailoring Option from the entire Section. 
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To access the complete list of 
Tailoring Options for an entire Job, 
right-click on the Job name and 
select the Tailor Job option as shown 
below: 
 

 

 
 
All Tailoring Options in the Job are 
listed in this window. From here, you 
can globally choose to keep or 
remove the available Tailoring 
Options for the entire project. To 
remove/hide an option, uncheck the 
box beside it. 

 

 Unchecking a Tailoring Option under any Section here also unchecks it from every Section in the 
Job (e.g., when AIR FORCE was unchecked in Section 01 33 00, it was also automatically 
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unchecked in every other Section in the Job). This ensures that the pre-editing of these options 
is applied everywhere those options exist throughout every Section in the Job. 
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SpecsIntact Section Essentials 
 
Knowing the basic structure of a SpecsIntact Section is key to the basics of properly editing and/or 
reviewing a Section for accuracy. For SpecsIntact’s automated features to make your work easier and 
your completed project accurate, you need to understand and follow some important formatting 
guidelines. This begins with understanding SpecsIntact tags: what they are, how they are used to 
format Sections, and how they identify components within a Section. 
 

 Some of the biggest and most time-consuming mistakes made by new users of SpecsIntact 
come from ignoring the structure and tagging requirements. If you learn these, your editing 
tasks will be much easier. 

 
 
Importance of Starting with Latest UFGS Sections 
 

Use the latest UFGS Master Sections, as they contain the most current information for your project. 
 
The UFGS Master database is updated and released quarterly in February, May, August and November 
each year. By default, when you open SpecsIntact, the system checks for updates to the UFGS Master 
and prompts you to download the newest UFGS Master if one is detected. 
 
This chapter will focus on important things to be aware of when editing a Section for use in 
SpecsIntact projects. When a UFGS Section is added to a Job (project) from the UFGS Master, it has all 
the necessary components (PARTS, Subparts, etc.), is already formatted properly, and contains all the 
necessary system tags. Understanding this is key to producing the most complete and accurate 
Section content. 
 
 

Section Structure 
 
For SpecsIntact’s automated features to make your work easier and your completed project accurate, 
you need to understand and follow some important formatting guidelines and understand how a 
Section is structured. 
  

CHAPTER 3: SECTION 
STRUCTURE AND TAGS 
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Section System Identifier and Date Tags 
 
Each Section begins with a line that contains the Section (SEC) tag followed by one or more meta 
(MTA) tags (this line is not visible when tags are hidden, and it is not printed). It is followed by the 
Section Number (SCN), Section Title (STL) and Date (DTE), each on a separate line as illustrated below. 
 

 
 
 
Parts and Subparts 
 
Formatting is everything to making a specification Section easier to read. SpecsIntact offers many 
options to make this easy if you know which tags to use. 
 
Following the Section header information, the body of the Section is broken down into three Parts 
that conform to the Construction Specifications Institute's (CSI) standard three-part format. 

Think of Section structure like a numbered outline. Each Section has three major top levels called 
Parts. All numbered paragraphs within each part are called Articles and Subparts. As you add or delete 
these while editing, the SpecsIntact Editor renumbers the Articles and Subparts accordingly, provided 
they are tagged correctly. 

  Parts are not automatically renumbered as all three Parts are required in every Section – no 
more/no less! The only exception to this rule is Section documents in the UFGS Master 
Division 00 - PROCUREMENT AND CONTRACTING REQUIREMENTS. 

The titles of the three standard Parts cannot be changed, and the titles should be exactly as shown 
below in ALL CAPS with three spaces between the PART number and the TITLE. 
  

PART 1   GENERAL (Contains the ‘1.x REFERENCES’ and '1.x SUBMITTALS' Article’s) 
PART 2   PRODUCTS  
PART 3   EXECUTION 

 
Each Part contains a specific type of information: 
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1. PART 1 GENERAL covers specific administrative and procedural requirements unique to the 
Section. 

 

  There are two specific Articles that if they are included in a Section, must reside in PART 1 
GENERAL. These are the ‘1.x REFERENCES’ and ‘1.x SUBMITTALS’ Article’s. Additionally, if 
they are both included, the Reference Article always appears above the Submittals Article. 
This specific placement is imperative to both Reference and Submittal processing and 
Verification Reports. 

 
2. PART 2 PR0DUCTS describes the quality of items required for the Job. 

 
3. PART 3 EXCECUTION details preparatory actions and explains how the products outlined in 

Part 2 are to be used in the Job. 
 
If a particular Part does not apply to a Section and contains no information, it should NOT be deleted, 
it should simply be noted within text tags as not used. See the example below: 
 

Shown with tags ON With tags OFF 

  
 
Notice in the example above the proper insertion of the PRT tags. 
 
In the graphical picture of a typical Section structure below, notice that Parts have their own 
beginning and ending PRT tags. However, Articles and Subparts (Paragraphs and Subparagraphs) all 
share the same beginning and ending Subpart (SPT) tags. You can tell what level a Subpart tag 
represents by looking at the level number contained inside the tag, such as <SPT =1.1.2>. This would 
represent PART 1, Article 1, Paragraph 2. 
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Inside a Subpart: Articles, Paragraphs and Subparagraphs 
 
Subparts are used within each of the three Parts to create sub-level paragraphs. Proper paragraph 
tagging and the effective use of these Subparts (including multiple levels within them) are essential for 
ensuring a specification Section is organized and easy to read. 
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The first Subpart level under a Part is known as an Article. The second and third level Subparts are 
Paragraphs and Subparagraphs, respectively. The actual paragraph text within these use TXT, LST and 
ITM tags, which provide three levels of normal paragraph (un-numbered) indentions. 
 
The SI Editor will allow you to insert almost unlimited Subpart paragraph sublevels. However, refer to 
the part and Subpart numbering information in the UFS 1-300-02 which currently advises using only 
six levels (seven if you count the Part as a level). Additionally, each Subpart is required to have a Title. 
The screenshot example below is taken from the SI Editor Navigator. Look at Subpart 3.2 HARBOR 
WATERWAYS through 3.2.1.1.1.1.1 Annual Pearl Harbor “Hydrofest” for a visual picture of this. 
 

 
 
 
Insert Subpart Template and Title Capitalization Rules 
 
Subpart title capitalization rules depend on what level the Subpart is: 
 

a. Top-Level Subpart Titles (Articles): should always be in ALL CAPS like Part Titles. 
b. Sub-level Subpart Titles (Paragraphs and Subparagraphs): should always be in Title Case.  

 

    If you use the Subpart  button, a Subpart template is inserted that contains all the 
          components of a Subpart: 

 
• Subpart (<SPT =1.5> </SPT>) tags. 
• The applicable Subpart number (e.g., 1.5). 
• TTL tags with fill-in brackets that guide you with the correct title case displayed. 
• TXT tags with fill-in brackets to guide you as to where to insert the Subpart paragraph text. 

 

https://www.wbdg.org/dod/ufc/ufc-1-300-02
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Text Paragraphs – Indent Levels/Tags  
 
Within each Subpart, regular text paragraphs have three paragraph indentation tag options: TXT, LST, 
and ITM. All three of these, by default, are used for normal, left-justified paragraphs, just with a slight 
tabbed indent depending on which one you choose. Please note that while each paragraph itself uses 
single lines, standard format directs you to insert a blank line in between each paragraph. 
 

With tags ON: 
 
<TXT>Regular paragraph TEXT TAGS.</TXT> 
 
     <LST>Indented paragraph – first level – left justified.</LST> 
 
          <ITM>Indented paragraph – second level – left justified.</ITM> 

With tags OFF: 
  
Regular paragraph TEXT TAGS. 
 
     Indented paragraph – first level – left justified. 
 
          Indented paragraph – second level – left justified. 

  
  
Both the LST and ITM tags above have additional indent options for manually entered lettered and 

numbered lists. To access this, simply click the Toggle Indentation  button on the SI Editor Toolbar 
when your cursor is within a set of LST or ITM tags. The indention option was previously used for 
manually inserting lettered and/or numbered items with a left-blocked format, as shown below. 
However, these lists are not capable of auto re-numbering and are also limited to just one automatic 
indent level (-0.33). 
 
See examples with tags ON and OFF below: 
 
With tags ON: 
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With tags OFF: 
 

 
 

The approved/standard indented list lettering and numbering options are as shown below. Note that 
these are also required to be double-spaced: 
 

 
 
SpecsIntact's new Ordered List function offers automatic numbering and is now the preferred method 
of inserting lists. 
 

  Additional information can be found on ordered lists under the Ordered Group & List Paragraph 
Tags with Automatic Numbering topic in this guide. 

 

 For additional guidance, watch the SI Editor and Section Structure Overview eLearning module 
within Chapter 3 – Editing. 

 
 
Ordered Group & List Paragraph Tags with Automatic Numbering 
 
The SI Editor’s new Ordered List function with the auto renumbering feature makes the previously 
noted ITM and LST tags and indention options obsolete, although they are still accessible and able to 
be used. 
 
To insert a new Ordered List, perform the following steps: 
 

1. Place your cursor on the blank line where you want to begin the list and click the Ordered List 

 button. This inserts a set of Ordered List (OLI) tags inside Ordered Group (OLG) tags. This 
completes the first lettered list item template text. 

https://www.wbdg.org/dod/specsintact/elearning
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 If you use the Ordered List  button, the Ordered List template is inserted and contains 
all the needed tagging components, as well as a bracketed option for you to enter the 
applicable item text. 

 

 
 

2. To add additional list items on the same level, press the Enter key once, then click the Ordered 

List  button again for each additional item you want to add. If you want sub-levels of the 
first level, just press the Tab key on your keyboard while your cursor is inside the OLI tags of 
that item – up to the four approved levels shown below. You should not go out more than 
those four standard/approved levels. 

 
With tags ON: 
 

 
 
With tags OFF: 
 

 
 
Notice the ordered list letters and numbers are recorded in the applicable beginning OLI tag as an 
attribute of that tag. This is how SpecsIntact keeps track of what level the items are so it can perform 
its auto-numbering. Also note, what level gets inserted depends on where your cursor is when you 

click the Ordered List  button. 
 

  To learn more about SpecsIntact ordered lists, refer to the Ordered List topic in the Web-Based 
Help. 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_OrderedList_Overview.htm
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SpecsIntact Tagging 
 
It is very important to pay attention to the accuracy of tag placement and spacing when entering new 
text into a Job Section. The following topics will detail correct editing practices as it pertains to the 
above goal. Incorrect tagging of added text may result in errors and erroneous information on 
SpecsIntact verification reports. Likewise, incorrect deletion of text can also cause similar issues.  
 

  Every piece of text within a SpecsIntact Section needs to be enclosed by its applicable 
beginning and ending tags. This applies from the Section (<SEC>Section</SEC>) tags that define 
the entire Section, down to the Part (PRT) and Subpart (SPT) tags, and all other tags identifying 
additional components within the paragraphs of those Parts and Subparts. 

 
Additionally, it’s important to realize that each SpecsIntact tag has its own default font settings. For 
instance, tags associated with a note (NTE & NPR) have a Bold text font applied to them, and other 
tags, such as those associated with Reference (RID) and Submittal (SUB) tags are color-coded to make 
them stand out. These fonts should NOT be altered to maintain consistency throughout the projects 
they are used in. 
 

  To learn more about SpecsIntact tags, refer to the SpecsIntact Tags topic in the Web-Based 
Help. This help topic lists and defines each SpecsIntact tag. 

 
 
The Keys to SpecsIntact - Tag Relationships 
 
As stated previously, you cannot successfully use SpecsIntact without understanding and using the 
tags correctly. Taking time now to learn about tagging will pay off in the long run. 
 
The tagging system used in SpecsIntact is similar to its better-known relative, Hypertext Markup 
Language (HTML), that makes web pages display correctly in your web browser. In much the same 
way, SpecsIntact uses tagging to distinguish between all the different elements of a Section. 
 

  It is possible to view a Section on your screen without viewing the tags, but when editing, you 
should always have the tags visible to avoid big problems. This is discussed in more detail later 
in this User Guide. Without the tags visible, your cursor may not be located where you think it 
is, and you may be deleting necessary information and tagging. It’s vital that your tagging is 
correct so that all the elements within your Sections are identified properly. 

 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SITags%2FSpecsIntactTags.htm


 
 

40     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

  Most tags come in pairs: the beginning and ending tags encompass the text information they 
define. Notice that the end tag is distinguished by a forward slash / within the tag (e.g., 
<SUB>Text</SUB>). 

 
While the tags immediately surrounding information identify it, that information is also contained 
within other higher-level tags that have a relationship to it as well. 
 
Think of it like a family tree: Mary is tagged as <wife> inside the <marriage> tags, but she is also 
tagged with <mom> tags, too. Outside of the marriage tags, in her extended family, she carries other 
tags like <daughter>, <sister>, <granddaughter> and so on. This is much like the tagged elements in 
your specifications. A measurement for English (ENG) units, for instance, may also be within tags for 
text, Subpart, Subparagraph, Paragraph, Article, Part, a Reference or Submittal and ultimately, the 
parent tag: Section. 
 
With tagging relationships in focus, your editing will go more smoothly. 
 
 
Tag Rules 
 
Every set of tags either completely encompasses another set, or the set is completely contained within 
another set of tags. Tags should never be interlinked. See the graphic examples below: 
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 Tags are not typed, they are inserted using either the corresponding button on the Tagsbar of 
the SI Editor, or by using the Insert menu > Tags option which allows you to choose the tag 
you want to insert from the drop-down box. Inserting tags using these methods ensures that 
they are placed correctly and that both beginning and ending tags are used. 

 
Important Notes and Additional Tagging Rules: 

 
1. ALL content in a Section must be tagged. 
2. Every Section must begin with a <SEC> tag and end with a </SEC> tag. 
3. The <SEC> tag is followed by a meta tag line: <MTA NAME=SUBFORMAT CONTENT=NEW/>. 
4. All three Parts must begin with a <PRT =#> tag and end with a </PRT =#> tag. 
5. Every Article must begin with a <SPT =#.#> tag and end with a </SPT =#.#> tag. 
6. Every Paragraph must begin with a <SPT =#.#.#> tag and end with a </SPT =#.#.#> tag. 
7. Every Subparagraph must begin with a <SPT =#.#.#.#> tag and end with a </SPT =#.#.#.#> tag. 

 
 
Entity Tags 
 
There are only four SpecsIntact Entity tags. These Entity tags do not have a beginning and ending tag 
like all other SpecsIntact tags. They are single tags that when you have View Tags toggled ON you see 
the tags, when your View Tags option is toggled OFF you see the text that the Entity tag represents. 
See the examples below: 
 

a. <AST/> - Asterisk line. When tags are OFF, this tag displays as a line of asterisks. It is only 
inserted before and after specifier notes and displays as: 
************************************************************************** 
 

b. <EOD/> - End of Document. Inserted at the end of all SpecsIntact documents (not Sections). 
When tags are OFF, this tag displays as: 
-- End of Document --  
 

c. <END/> - End of Section. Inserted at the end of all SpecsIntact Sections (.sec files). When tags 
are OFF, this tag displays as: 
-- End of Section – 
 

d. <NED/> - Need tag. Inserted near the end of all SpecsIntact Sections (.sec files). When tags are 
OFF, this does not display at all. This entity tag is used to identify additional text that is needed 
to print on the last page of the Section file. For example, so -- End of Section -- or -- End 
of Document -- does not print on the page by itself. Essentially, this is a smart page break. 
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Tailoring Option Tags 
 
Text that is considered a Tailoring Option is surrounded by Tailoring (TAI) tags. Text within tailoring 
tags defaults to the same teal color of the tag, so even with tags off it is easily recognized as tailored 
text. These tailoring tags are then further defined by an added attribute to identify what specific 
Tailoring Option should be used on a particular term, sentence, or piece of text. Text tagged as a 
Tailoring Option can be turned off or removed to exclude various requirements or agency-specific 
information that does not apply to the current project. 
 
See a perfect example of different Tailored Options that appear in almost every UFGS Master 
specification Section in the Submittal Article’s first text paragraph: 
 

 
 
As you can see above in the first tailored sentence, you can also have multiple tailoring attributes that 
apply to the same text. In this example both AIR FORCE and NAVY agree on and therefore prefer to 
use the same sentence here. ARMY, on the other hand, requires a completely different sentence to be 
followed for guidance here. 
 

  In the first instance where the Tailoring attributes are both AIR FORCE and NAVY, the 
specifier would have to choose to deselect (turn OFF/hide) both of those specific Tailoring 
Options for that sentence to get hidden/removed. If only NAVY is turned OFF, and not AIR 
FORCE, this text would remain in the Section and vice versa. Only by deselecting both AIR 
FORCE and NAVY would the sentence get automatically hidden. 

 
 
Tags and References 
 
SpecsIntact helps automate the use of References in your Job. This great time saver is controlled using 
a family of tags that identify the Reference-related elements, a listing of References within each 
Section, and a Section listing all referenced publications. Your goal at the end is to have these lists 
reflect only the References used within your Job, a task SpecsIntact will accomplish for you during the 
Reference Reconciliation process at time of print. Of course, it is dependent on any added information 
being inserted and tagged properly. 
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  Additional information on References can be found under the Reference Reconciliation and 
Verification Report and SI Editor’s Reference Tool and Wizard topics in this guide. 

 
 
Section 01 42 00 (Address Section) 
 
The content of the References cited in the individual UFGS Master Sections is considered part of the 
specifications. UFGS Section 01 42 00 ‘Sources for Reference Publications’ serves as a comprehensive 
directory, providing addresses and contact information for every Reference Organization cited within 
the UFGS Master. For example: 
 

FEDERAL EMERGENCY MANAGEMENT AGENCY (FEMA) 
615 Chestnut Street 
One Independence Mall, Sixth Floor 
Philadelphia, PA  19106-4404 
Ph: 215-931-5597 
E-mail: femar3newsdesk@fema.dhs.gov 
Internet: https://www.fema.gov/ 

 
As mentioned earlier, this Section is required in all projects and is automatically added when you 
create a new Job. During processing, the Reference Address list contained in Section 01 42 00 will be 
used to check the Reference Publications in each project Section for validity. 
 

  Since UFGS Section 01 42 00 only contains Reference Organizations and their address 
information, and all related processes and reports have ‘Address’ in their name, we often refer 
to this Section as the ‘Address’ Section. 

 
The 01 42 00 Sources for Reference Publications Section contains tagged information for every single 
Reference found in the entire UFGS Master database: 
 

1. Reference (REF) tags surround all the applicable Reference information as well as their tags for 
each reference publication listed. These tags and details are listed below: 
 
a. Organization (ORG) tags enclose the name of the sponsoring organization. 

 
b. Organization Address (OAD) tags surround the address, phone, fax, email and Internet 

information for each sponsoring organization. 
 
Example: 

mailto:femar3newsdesk@fema.dhs.gov
https://www.fema.gov/
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  Additional information on Reference addresses can be found under the Address Reconciliation 
and Verification Report topic in this guide. 

 
 
Reference Identifier (RID) Tags and Structure Within Other Sections 
 
Within each UFGS Master Section, a listing of References used in that Section is contained in PART 1 
GENERAL within the Reference Article. Each Reference is surrounded by Reference Identifier (RID) 
tags, and just as with Tailoring Options, the reference information inside the RID tags takes on the 
pink color of the RID tags so that even with tags turned OFF you can tell at a glance that you are 
looking at a Reference Identifier. 
 
It is important to note that you can add References to this list under the appropriate Reference 
Organization, but you should NEVER remove any References from this Article, as any you do not use in 
the edited Section text will be automatically excluded from the output files you produce during 
Reference Reconciliation processing. 
 

1. The Reference Article for each Section contains the following information: 
 

a. Reference (REF) and Reference Organization (ORG) tagged information is listed here for the 
applicable organization. NOTE: The Reference Organization Address (OAD) information is 
not listed or needed here, it is only included in the 01 42 00 Section. 
 

b. All Reference Identifiers (RID) used throughout the current Section are listed here under 
their respective Reference Organization along with their applicable Reference Titles (RTL). 
 

c. Reference Titles (RTL) that correspond to the specific Reference Identifier (RID) are listed 
after each individual RID. 

 
Example below: 
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  Outside the Reference Article, you will only have context specific Reference Identifiers 
such as <RID>AWS D1.4/D1.4M</RID> shown below: 

 

 If a Reference Standard is called out in the body of the Section anywhere, it must be tagged as a 
Reference (RID) by inserting the applicable Reference Identifier (<RID>AWS D1.4/D1.4M</RID>) 
tags around it in the text of the Subpart. You must also make sure it is listed in the Reference 
Article under the applicable Reference Organization (ORG), along with the latest date and title for 
that Reference Standard. 

 

  Additional information on References can be found under the Reference Reconciliation and 
Verification Report and SI Editor’s Reference Tool and Wizard topics in this guide. 

 

 For additional guidance, watch the References eLearning modules within Chapter 3 – Editing. 
 
 
Tags and Submittals 
 
Submittals are items, such as samples or drawings, that must be provided by the contractor. The 
Submittal Register (discussed in more detail later in this User Guide) can be generated from your Job 
to show all the Submittals in the entire project in a grid format. 
 
 
Section 01 33 00 Submittal Procedures 
 
SpecsIntact also automates the use of Submittals in your Job, which brings us to the second of the two 
Sections necessary to process a finished Job: the 01 33 00 Submittal Procedures Section. This Section 
lists all the Submittal Descriptions, as well as pertinent instructions. Submittals fall into one of eleven 

https://www.wbdg.org/dod/specsintact/elearning
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(11) assigned Submittal Descriptions, containing numbers and names, that should not be altered. 
These are listed below: 
 

SD-01 Preconstruction Submittals SD-07 Certificates 
SD-02 Shop Drawings SD-08 Manufacturer's Instructions 
SD-03 Product Data SD-09 Manufacturer's Field Reports 
SD-04 Samples SD-10 Operation and Maintenance Data 
SD-05 Design Data SD-11 Closeout Submittals 
SD-06 Test Reports  

 
1. The ‘01 33 00 Submittals Procedures’ Section contains the following tagged information: 

 
a. Submittal (SBM) tags are found only in this 01 33 00 Section and surround the information 

and tags for each Submittal Description and Submittal Definition. 
 
b. Submittal Descriptions (SD Numbers and Titles) are surrounded by SUB tags, which are 

within a set of TXT tags.  
 

c. Submittal Definitions are surrounded by List (LST) tags. 
 
Example: 

 

 
 

  Additional information on Submittals can be found under the Submittal Reconciliation and 
Verification Report topic in this guide. 

 
 
Submittal Identifier Tags and Structure within Other Sections 
 
Within all other UFGS Master Sections, Submittal Items are each listed under their corresponding 
Submittals Descriptions contained under PART 1 GENERAL in the ‘1.x SUBMITTALS’ Article. Only 
Submittal Items used elsewhere within the Section should be listed in the Submittal Article, and they 
must be identical and tagged properly to enable the system to process the information correctly. The 
Submittal Article can be edited. 
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  Outside the Submittal Article, you will only have corresponding Submittal Items surrounded 
by SUB tags, such as ‘Formwork’ in the example shown above and below. It is not necessary to 
include the applicable Submittal Description (e.g., SD-02 Shop Drawings) in the text of the 
Section. 

 

  In addition to the information contained in each Section of a Job, another system generated 
report called the Submittal Register can be produced when printing a Job, provided that the 
Submittals have been correctly tagged wherever they appear. It lists the materials, products 
or items for each Submittal, and cites the Section and Subpart or Article number where the 
Submittal is mentioned in the Job’s text. NOTE: Most projects require the Submittal Register. 

  Additional information on Submittals can be found under the Submittal Register and SI 
Editor’s Submittal Tool and Wizard topics in this guide. 

 

 For additional guidance, watch the Submittals eLearning modules within Chapter 3 – Editing. 
 
 
Tags and Section References 
 
Within almost every UFGS Master Section, there are multiple places where the current Section refers 
to another UFGS Master Section that contains related information in addition to the current Section. 
These are called Section References, and of course, SpecsIntact has a tag for that: SRF. Every place in a 
UFGS Master Section that refers to another Section has Section Reference (SRF) tags inserted around 
just the Section Number. When inserting a new Section Reference into a project Section, note that it 

https://www.wbdg.org/dod/specsintact/elearning
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should be inserted EXACTLY as shown in the example below. The Section Number should be 
immediately followed by the Section Title in ALL CAPS: 
  

SECTION <SRF>01 33 00</SRF> SUBMITTAL PROCEDURES  
  
This is the only way that SpecsIntact can ensure that every Section Reference has a valid UFGS Master 
Section that matches the Reference. Any discrepancies will be listed on the Section Verification 
Report, providing the Section References are keyed in correctly and accurately tagged. This report will 
be discussed in more detail later in the training. 
 
 
Additional Tags 
 
Listed below are some additional tags that are easily available on the SI Editor Tagsbar: 
 

 
 

1. Highlight <HLS> - when HLS tags are inserted around text, the text turns orange to stand out. 
This tag is often used to call the Project Manager or specifier’s attention to text as the 
specifications are being prepared. 
 

  The HLS tags have no effect on the final, processed Sections. Additionally, you can easily 
remove these from all Sections in your Job by right-clicking on the Job name and selecting 
the Remove Change/Highlight Tags option. 

 
2. Bold <BLD> - insert around text to be bolded. 
3. Italics <ITA> - insert around text to be italicized. 
4. Underline <UND> - insert around text to be underlined. 
5. Center <CTR> - insert around text to be centered. 

 

 For a complete list of SpecsIntact tags, refer to the SpecsIntact Tags topic in the Web-Based Help. 
This help topic lists and defines each SpecsIntact tag. 

 
 
Units of Measure Tags and Use of Symbols 

 
As previously noted, you can choose to use either English or Metric units of measure in your project. 
These measurements are identified in UFGS Sections by the applicable tags that surround each unit of 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SITags%2FSpecsIntactTags.htm
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measure. The tags and text are blue or red depending on whether the unit is an English or Metric 
measurement, making units of measure easily recognizable with or without tags turned on: 
 

1. English <ENG> (e.g., <ENG>5 inches</ENG>) 
2. Metric <MET> (e.g., <MET>12.7 centimeters</MET>) 

 
Standard format requires you to spell out the units of measure and to not use symbols only in certain 
cases. Some examples are noted below: 
 

• Spell out feet when no inches are used. (e.g., 8 feet) 
• Spell out inches when no feet are used. (e.g., 8 inches)  
• When using both feet and inches, it is permissible to use symbols. (e.g., 8'-8", 8'-2-1/2") 
• Use numbers whenever possible, and always for dimensions. When defining both quantity and 

dimensions, use the written word for quantity and the number for the dimension. (e.g., three 
1/2-inch holes) 

• Always use figures for degrees, percent, and money (e.g., 50 degrees F (20 degrees C), 20 
percent, $5.50). 

• Decimals should be expressed in figures. (e.g., 6.235) 
 
 
Symbols Not Allowed 
 
Because of potential problems, the following items should be written instead of using their 
representative symbols: 
 

• percent (not %) 
• degree (not °) 

• plus (not +) 
• minus (not -) 

• by (not X or x) 
• per (not /) 

• at (not @) 
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SpecsIntact Editor Overview 
 
Now that you are familiar with the basic structure of a UFGS SpecsIntact Section (detailed in the 
previous chapters), the SpecsIntact Editor offers many easy ways to insert the proper tags and utilize 
helpful tools via the SI Editor’s Navigator, buttons, and toolbar options to ensure clean editing. 
 
 
SI Editor Shortcut Buttons/Toolbars 
 
Shown in the screenshot below is the SI Editor menus, the Toolbar, and the Tagsbar. The toolbars 
contain a collection of the most frequently used options when editing a specification Section. 
  

 
 
Many common commands are accessible from both the menus and the toolbars. A few of them are 
familiar Windows-standard functions such as cut, copy, and paste. Others, such as the commands to 
show or hide screen elements like tags, notes and revisions, are specific to the SI Editor. 
 
Clicking a button on the Tagsbar inserts a pair of the selected tags. You can either insert the tags then 
type the information between them, or type the information first, select it, then click the applicable 
tag button to insert the tags around it. 
 
NOTE: When accessing options via the menus, you will also see any applicable keyboard shortcuts that 
are available to use in lieu of the functions/buttons on the toolbars. 
 

 For additional guidance, watch the SI Editor and Section Structure eLearning module within 
Chapter 3 - Editing. 

 
 
SI Editor’s Navigator 
 
The SI Editor’s Navigator layout has the look and feel of a Table of Contents/Bookmarks pane and 
provides ‘jump to’ and ‘quick editing’ functions. 
 

CHAPTER 4: SI EDITOR - VIEWING 
AND EDITING SECTIONS  

https://www.wbdg.org/dod/specsintact/elearning
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Jump to Subpart: To quickly navigate to a particular 
Subpart, simply click on that Subpart and your cursor will 
jump to that place in the Section. 
 
Expand/Collapse All: You can easily expand or collapse all 
Subpart levels by right-clicking on any Part or Subpart and 
selecting either option. You can also manually expand or 
collapse individual Subparts just by clicking on them. 
 
Delete a Subpart: To delete a Subpart quickly and easily 
(see 1.4 in the picture) simply click on that Subpart and 
press the Delete key, or right-click and select Delete. 
 

 Deleting a Subpart from the Navigator must be done with attention to detail. If you delete a 
Subpart that has additional Subpart levels under it, they will also be deleted (e.g., in the 
picture above, if 1.4 is deleted, 1.4.1 and 1.4.2 will also be deleted, as they are part of 1.4). 
 

Navigator Icon Descriptions: Icons pictured beside Subparts indicate the Subpart status and current 
paragraph attributes, as shown below: 

 

   

For additional guidance, watch The Navigator eLearning module within Chapter 3 – Editing. 

https://www.wbdg.org/dod/specsintact/elearning
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Viewing Sections in the SI Editor 
 
When you open a UFGS Specification Section in the SI Editor you have many options on how and what 
to view in the Section. All options can be found either on the View menu or the SI Editor’s Toolbar. 
For now, we are focused on the most frequently used ones, that are grouped together on the SI 
Editor’s Tagsbar: 

 

 

1 2 3 4 

    
 

1. Revisions (Shift+F8): If you are required to Use Revisions (aka track changes) while performing 
edits to your Job Sections, then you should have Revisions turned on before beginning any 
edits. Using this feature will place Delete (DEL) tags around all deleted text and will insert Add 
(ADD) tags around any new text. NOTE: The text within these ADD and DEL tags changes to the 
applicable red or green color of the tags. This is how the SI Editor handles tracking revisions. 

 
2. Toggle Tags View (Alt +S): Always edit with the tags visible on the screen. You can hide tags to 

check the formatting, but when you make any changes, it is important to view the tags. 
Following this rule will prevent major errors and possible tagging issues. 

 

a. Use the Toggle Tags View  button to quickly toggle View Tags off and on or utilize 
the keyboard shortcut Alt+S. 

 
3. Toggle Notes View (Alt+N): Working with Notes visible on the screen is most helpful if you are 

the specifier doing the editing. If you are not, then you may find it helpful to toggle View Notes 
off so that you have less to look at while editing. 

 

a. Use the Toggle Notes View  button to quickly toggle View Notes off and on or 
utilize the keyboard shortcut Alt+N. 

 
4. Toggle Revisions View (Alt+R): If you have Revisions turned on to track your additions and 

deletions, you can use the Toggle Revisions View  button to view or hide all deletions. 
NOTE: All added text will always be visible. 
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  It is recommended to toggle View Revisions ON and OFF frequently while editing as this 
allows you to check that the formatting and spacing is accurate by hiding the deleted text 
when View Revisions is toggled to OFF. 

 
 
Viewing Tailoring Options in the SI Editor 
 
When you first open a Section in the SI Editor, the Tailoring Options window pops up displaying all the 
available Tailoring Options for the open Section. 
 

 
 
To hide any of them, click to deselect/hide. If you previously deselected any as part of pre-editing your 
Job, they will already be deselected and possibly redlined here if Revisions were on at the time they 
were pre-edited out. 
 

 Additional information on how to view Tailoring Options in the SI Editor can be found 
under the Using Tailoring Options to Pre-Edit a Job topic in this guide. 

 
If Revisions are turned ON in the SI Editor and you select any Tailoring Options to hide, you will be 
prompted upon saving the Section if you want to delete all hidden Tailoring Options. 
 

• Click Yes to permanently delete the hidden Tailoring Options. 
• Click No to keep them hidden but not deleted. 
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 To change whether the Tailoring Options window pops-up by default, check or uncheck the 
Show this dialog box when opening Sections with Tailoring Options option per your 
preference (see red arrow in first screenshot above). NOTE: We highly recommend you keep it 
checked to remind you of the existence of the Tailoring Options each time you open a Section. 

 

 If you did not use the pre-editing option to deselect/hide Tailoring Options when you first 
created a Job, it is not too late to use the SI Editor’s Tailoring function above or return to the SI 
Explorer to tailor the Sections at the Job level. Either way, Tailoring Options are meant to be a 
time saver! 

 
 

Proper Editing Practices in the SI Editor 
 
Clean editing practices are essential to producing an error-free specification Section. The following 
topics focus on the available techniques and the most recommended editing methods. 
 

 First important rule when editing a SpecsIntact Section is to always have View Tags turned 
ON. 

 

 To display paragraph marks and spaces, either go to the SI Editor’s View menu and select the 
Marks option or click on the Show Marks  button on the Toolbar. Each space will be 
represented by one dot on the screen. 

 
 
Editing Tips 
 
Adding and deleting text can be tricky in the SI Editor. Some of the best practices and editing methods 
are outlined below. 
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 As you are editing, the general rule is to leave one blank line between paragraphs. Keep this in 
mind and add or delete any extra blank lines or spaces as needed while you are adding or 
deleting text. 

 
Adding New Text 
 
All plain text must be surrounded by formatting tags such as TXT, LST or ITM tags. There are a couple 
of ways you can accomplish this: 
 

 
 

1. Enter the text first. Next, highlight it and click the applicable formatting tag on the Tagsbar. 
 

OR: 
 

2. Place your cursor where you plan to enter the new text, click the applicable formatting tag on 
the Tagsbar, then start typing the text inside the tags. 

 

 Additional information on the difference in the TXT, LST and ITM text formatting tags can 
be found under the Text Paragraphs – Indent Levels/Tags topic in this guide. 

 
 
Deleting Text 
 
It’s important to pay attention to exactly what you are deleting in the SI Editor. If you only need to 
delete some of the information between tags, do NOT delete the tags. An example would be: 
 

<TXT>Floor covers shall be maintained in good condition.</TXT> 
 

EDIT TO READ: 
 

<TXT>Floor covers shall be maintained.</TXT> 
 
When you remove the words ‘in good condition’ from the original sentence, you must be careful not 
to remove the TXT tags, as this will result in untagged text. 

 

 Leaving untagged text in a Section can cause formatting issues - at a minimum! 
 
If, on the other hand, you DO want to remove the entire sentence, you would need to include and 
delete the beginning and ending TXT tags. There are a couple of ways to do this cleanly: 



 
 

56     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

Method 1: 
 

1. Select all the information including both beginning and ending tags, either by highlighting it 
before the beginning TXT tag and after the ending TXT tag. 

2. Press the Delete key on your keyboard to delete the text selection. Alternately, you can 
click the Delete button on the Tagsbar or press Ctrl+D which is the keyboard shortcut. Be 
sure to check your spacing when done to make sure no blank lines or extra spaces are left. 

 

 Another method to highlight the text and the tags is to place your cursor anywhere 
inside the TXT tags, then double-click to select a single word, pause, then double-click 
again to include the rest of the text including the beginning and ending TXT tags in the 
highlighted text. 

 
Method 2: 

 
1. Place your cursor to the immediate left of the beginning TXT tag. 
2. Hold down the Shift key while pressing the Delete key (Shift-Del). This cleanly deletes the 

tags and the text within them. As always, check spacing and correct as necessary. 
 

  For additional guidance, watch the Deleting Subparts eLearning module within Chapter 3 – 
Editing. 

 
 
Using Revisions to Track Changes 
 
Just as in Microsoft Word, the SI Editor provides a way for you to use the Revisions function to track 
your changes as you perform edits. 
 
The Revisions feature calls for close attention especially since it is the standard setting. Before you 
ever begin to edit the first Section of your Job, you need to know if you are required to show 
Revisions. If you know that you do NOT have to use Revisions when you set up your Job, you can 
disable it from the Options tab in the Create New Job window. 
 
When using Revisions to track changes, any text that is deleted gets surrounded by Delete (DEL) tags 
and turns the deleted text red and overstruck, while any newly added text gets surrounded by Add 
(ADD) tags and turns the text green and underlined. See example below: 
 

 
 

https://www.wbdg.org/dod/specsintact/elearning
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To turn the Revisions function ON or OFF, you must click on the Revisions  button. You can also 

choose to show or hide revisions as you are editing by toggling the View Revisions  button ON and 
OFF as you edit. When View Revisions is OFF, the SI Editor hides any text you have deleted (all text 
within DEL tags) while displaying anything that has been added (all text inside ADD tags). Turning View 
Revisions OFF after deleting or adding text is recommended to be sure spaces and formatting are 
correct. 
 

 The recommended practice when using Revisions to track changes in the SI Editor is to 
frequently toggle View Revisions and View Tags OFF and ON to double check the 
resulting formatting of edits so you can adjust for any extra or missing blank lines or 
spaces. 

 

 To learn more about using Revisions, please refer to the SI Editor Edit Menu – 
Revisions topic in the Web-Based Help. 

 
 
Subparts - Tag Placement and Automatic Numbering 
 
When editing a Section, you must be aware of how to properly insert or delete Subparts to ensure the 
renumbering function works correctly and as expected. It might be helpful to think of Subpart tags 
being nested inside of each other for each sublevel required. 
 
 
Adding Subparts 
 

Wherever your cursor is blinking at the time you click the Subpart  button to add a new Subpart 
determines what level of Subpart gets added. It’s recommended to practice adding and deleting 
Subparts to see the results, but the basic principle is shown in the following examples. 
 

Note that when you click on the Subpart  button, everything that is required to be included in a 
new Subpart - the Subpart (SPT), Title (TTL), and Text (TXT) tags - are added in the correct locations as 
shown in the highlighted text below. Additionally, inside both the TTL tags and the TXT tags, brackets 
are inserted indicating where to enter that information. This takes the guesswork out of having to 
manually insert every required tag and shows you exactly where to enter the Title and Text. 

 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_EditMenu_Revisions.htm
https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_EditMenu_Revisions.htm
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There are a couple different ways to add a Subpart. One way is the way described above; just click the 

Subpart  button and insert a blank Subpart template. In this example, your cursor was placed after 
the ending Subpart tag of Subpart </SPT =1.6>| and when the Subpart button was clicked, it added a 
new Subpart 1.7.  
 

NOTE: If the new Subpart needs to be inserted as 1.6.1 (a sublevel of 1.6), place your cursor 
just before the ending 1.6 tag |</SPT =1.6> as shown below: 

 

 
 

Next, click the Subpart  button and it will insert it at that level as shown below. Note that 
after the Subpart template is inserted, it leaves your cursor sitting inside the TTL tags ready for 
you to enter the Title. 

 

 
 

 

 Be very mindful of where you place your cursor before clicking the Subpart  
button so you get the expected Subpart level. 
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Promoting Subparts 
 
To easily increase the Subpart level, click on the applicable Subpart in the Navigator, right-click on it 
and select Promote Subpart (e.g., right-click on 1.6.1 to promote it to 1.7). This moves it to 1.7 and 
automatically renumbers the original 1.7 Subpart to 1.8. 
 

 
 

 If you have Revisions and View Revisions turned ON, the above actions will include DEL 
tags around the original promoted Subpart (1.6.1) and ADD tags around the newly 
promoted (1.7) Subpart. The Revisions tracking in the SI Editor considers the sublevel 
Subpart (1.6.1) to be a deletion and the new (1.7) Subpart to be an addition. See the 
example of this below. 

 

 
 
 
Deleting Subparts 
 
There are a few different ways to delete a Subpart. These ways are defined and explained below in 
detail. 
 

 Deleting Subparts can be tricky. This requires full attention so that more Subparts than 
expected do not get deleted. For instance, if you are wanting to delete 1.6, but not 
1.6.1, deleting 1.6 in any of the suggested ways noted below will also result in 1.6.1 
getting deleted, as it is part of 1.6. You would need to keep 1.6 and its title but delete 
any content under it OR promote 1.6.1 to 1.6 and capitalize that title. 
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Method 1: The easiest and most preferred way to delete an entire Subpart is from the SI Editor’s 
Navigator. Simply click on the Subpart and either press the Delete key on your keyboard, the Delete 
shortcut keys (Ctrl+D), or right-click on the Subpart you want to remove and select Delete from the 
menu. 
 

 Using the SI Editor’s Navigator to delete Subparts cleanly includes all the applicable 
beginning and ending Subpart (SPT) tags associated with that Subpart when you select and 
delete if from the Navigator. Whereas, when you choose to highlight and scroll to select a 
Subpart, it is sometimes easy to miss including all the applicable tags, which can then 
possibly cause Section validation errors. 
 

 WARNING: Be aware that if the Subpart you are deleting (e.g., 1.4 highlighted below) 
contains additional sublevel Subparts, those sublevel Subparts 1.4.1 and 1.4.2 will also be 
automatically deleted, as they are considered part of Subpart 1.4. To avoid this, start with 
all the Subparts expanded so you can view all the sub-level Subparts. When Revisions are 
turned ON, the SI Editor displays the deletion as shown below. 

 
NOTE: The deletions are visible in both the SI Editor Navigator and the Section itself. 

 

 
 

 Clicking the DEL  button on the SI Editor Tagsbar while selecting a Subpart in the SI 
Editor Navigator only deletes the Subpart Title, not the Subpart. This is because when 
you click on a Subpart from that pane, by default it only highlights the title in the Editing 
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window and the Toolbar buttons apply to the text in the Editing window not the 
Navigator. See the example below: 

 

 
     

Method 2: Place your cursor just before the beginning Subpart tags (e.g., <SPT =1.6.1> below) and 
press the Shift+Del keys on your keyboard. This will cleanly delete everything from that beginning 
<SPT =1.6.1> tag to the corresponding ending </SPT> tag. 
 

 
 

 Note that this method of using Shift+Del works to delete any pair of tags and the text within 
them, not just Subparts. 
 

Method 3: You can highlight the whole Subpart from the beginning SPT tag to the ending SPT tag then 
either press the Delete key on your keyboard, the Delete shortcut keys (Ctrl+D), or right-click on the 
highlighted text and select Delete. 
 

 In the SI Editor, it is not recommended to click and scroll to highlight large blocks of text 
when editing a SpecsIntact Section. If this is necessary, it is recommended for you to scroll 
slowly and methodically and pause frequently while scrolling to select text. Sometimes if you 
are highlighting and scrolling too fast, the SI Editor can lock up on you. 

 

  For additional guidance on adding and deleting Subparts, watch the Subparts eLearning 
module within Chapter 3 - Editing. 

https://www.wbdg.org/dod/specsintact/elearning
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Un-Deleting Subparts 
 
There are several ways to undelete a Subpart. Here are a few methods: 
 

1. Undeleting a Subpart from the SI Navigator: 
 

a. Right-click on the deleted Subpart and select Undelete. The DEL tags are removed but the 
text is left and therefore undeleted. 

 
2. Undeleting a Subpart from the SI Editor: 

 
a. To undelete a Subpart in the SI Editor, you must highlight all the deleted text, including the 

beginning and ending DEL tags, then right-click on the highlighted/deleted text and select 
Undelete Redlined Revisions. The DEL tags are removed but the text is left and therefore 
undeleted. 

 
b. Another way to undelete a Subpart in the SI Editor is to place your cursor just after the 

beginning SPT tag or just before the ending SPT tag, then right-click and select Remove 
Tags. You are asked to confirm it is the DEL tags you are wanting to delete. Click Yes. The 
DEL tags are removed but the text is left in and therefore undeleted. 

 
 

Bracket Replacement Tool  
 

SpecsIntact offers a Bracket Replacement Tool in the SI Editor. This helpful tool aids you in quickly 
and efficiently stepping through and making choices on all bracketed options in a Section. To activate 

this tool, simply click the Bracket Replacement  button on the SI Editor’s Toolbar. The Replace 
Bracketed Text window pops up and jumps to the first set of bracketed options, as shown below: 
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You can select one, none or both bracketed options. You can also choose to Ignore this set of brackets 
and jump to the next set. In the example above, you chose to keep the first option by selecting it to 
keep it. To proceed with keeping the top bracketed option and deleting the second option, click the 
Replace button. This results in the brackets around the first option being deleted, and the second 
option being deleted or redlined out in its entirety, as shown below with View Revisions turned ON: 
 

 
 
With Revisions turned OFF: 
 

 
 
IMPORTANT: Be aware that you must click on (highlight) the bracketed option you want to keep 
before you click the Replace button. If you don’t, it will be removed. 
 

 When it comes to using the Bracket Replacement Tool - REMEMBER – Click it to KEEP it! 
 

 
Bracket Replacement Tool Options 
 

The first thing to be aware of when using this tool is what the options on the Replace Bracketed Text 
window are and what each of them mean. See the screenshot of this tool and a definition of each 
below. 
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a. Select Item(s) to Add to Edit Box, Below: This is the part of the window where the currently 
selected bracketed option(s) appear. You must select each applicable bracketed option you 
wish to keep. Then click the Replace button. See the list of all the available buttons/options to 
choose from: 

 
• Replace - Replaces bracketed item(s) based on your other selections. 
• Ignore - Ignores this bracketed option and moves to the next one. 
• Cancel - Cancels the Bracket Replacement Tool and closes the window. 
• Help - Loads the related Bracket Replacement Tool help topic. 
• Undo Last - Only available if you already performed at least one Bracket Replacement. 
• Hide Details - Hides the additional bottom options in this tool. If already hidden, this 

button displays as Show Details which when clicked displays the options as shown 
above. 

 
b. Replace Bracketed Text With: Choose which option to apply to the selected bracketed option 

in the top pane of the Replace Bracketed Text window. See a list of all available options: 
 

• Selected Item(s), Above - If an item was selected and then the Replace button was 
clicked, just the selected bracketed option in the main window is left, and all other text 
and brackets are removed. 

• Existing Text (remove brackets) - If selected and you click the Replace button, just the 
brackets around the bracketed text will be removed, leaving the text within the brackets 
behind. 
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• No Text - No text or brackets are left; it is all deleted. 
• New Text, Below - The bottom pane of this box is where you type in your own 

replacement text. As soon as you click in this bottom pane, this option is automatically 
selected. Any text you type here will be inserted in place of the selected bracketed 
option(s) in the top pane. 

 
c. Don’t Move This Dialog Box: The screen position of the dialog box (window) will remain fixed 

when this box is checked, even if it covers the selected bracketed options in the Section. When 
this box is unchecked, the dialog box (window) will move with each occurrence to allow you to 
see the location of the bracketed options within the Section text. 

 
d. Pause After Each Change: This is a recommended option so you can be sure to check spacing is 

correct as changes are being made. 
 

 Additional information on the Bracket Verification Report can be found under the Bracket 
Verification topic in this guide. 

 

  For additional guidance, watch the Brackets eLearning module within Chapter 3 – Editing. 
 
 

Inserting Formatted Tables 
 
Inserting a table in a SpecsIntact Section has never been easier since the implementation of the 

Formatted Tables feature. To insert a new table, simply click the Formatted Table  button on the 
SI Editor’s Tagsbar. This brings up the Insert Table window with a default number of columns, rows, 
header rows, and table border information to get you started: 
 

  

https://www.wbdg.org/dod/specsintact/elearning
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Insert Table Options  
 
You can choose how many columns and rows you want and indicate if one or more header row(s) are 
applicable. Additionally, you can choose when to display the border, with three choices of border 
styles to choose from. 
 

a. Size: 
 
1. Number of columns - default setting is 4 
2. Number of rows - default setting is 4 
3. Number of header rows (printed on each page) - default setting is 1 

 
b. Borders: 

 
1. Show borders:  

1. Never  
b. Only on Screen 
c. Only when Printing  
d. Always (default) 

2. Border styles:  
a. Thin (default)  
b. Medium  
c. Thick  

 
 
Additional Table Functions 
 
SpecsIntact offers some additional functions for customizing and editing tables. 
 
 
Changing Row Heights and Column Widths 
 
Among the available menu options for tables are those that allow you to adjust row heights and 
column widths based on the whole table or on selected cells. These menu options include, Row 
Height, Column Width, Make Selected Rows Same Height, and Make All Columns Same Width. 
 

1. To adjust the row heights or column widths on selected cells and make them the same size, 
you must highlight all the rows (or columns) you wish to adjust, then right-click and select the 
applicable option. 

 
2. To make all the rows or columns in the whole table the same size, you can simply hover over 

the table (without clicking in any cell), right-click and select the applicable option. 
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 If you get unexpected results, click outside of the table, and click the Undo button. 
You can also manually adjust the row heights and column widths by dragging them 
to the desired height or width. 

 

 When manually adjusting row heights one by one, it is important to note that they are 
aligned to a grid and must be adjusted from the bottom of the table upward. If borders 
are not dragged far enough, they'll snap to the closest grid line, which might result in the 
row being too small to contain the text. 

 
 
Importing/Exporting an Excel Table 
 
SpecsIntact does provide the functionality for importing and/or exporting tables to and from Excel. 
However, this is NOT a cut and dried process. Additionally, due to Microsoft security restrictions on 
government systems, the copy-and-paste method from the Excel file into a pre-inserted formatted 
table in the SI Editor is the recommended method to use. 
 

 To copy and paste from an Excel spreadsheet into a SpecsIntact table, you first need 
to create a table in the SI Editor with the same exact number of rows and columns as 
the Excel spreadsheet. Then you can copy-and-paste the data into the table. 

 
 
Table Menus - Hover Menu vs. Edit Mode Options 
 
When working with Tables in SpecsIntact, you have two Right-click menus available to you: the Hover 
menu and the Edit Mode menu. When you hover over the table and right-click, the table Hover menu 
pops up with access to functions and settings such as Merge/Unmerge Cells, Justify, Row Height, 
Column Width, Insert Rows/Columns, Delete, Select Table, Properties, etc. 
 
When you are in Edit Mode in a table cell (by double-clicking or left-clicking in any cell), you have 
access to the commonly used editing functions such as Cut, Copy, Delete, Paste, and the three 
Revisions functions, along with the main Table menu at the bottom. More than likely, most of what 
you will need to do can be accomplished through the Hover menu. See examples of each menu below: 
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Table ‘Hover’ Menu 
 

 
 

 

Table ‘Edit Mode’ Menu 
 

 

 There are a couple of things you need to be aware of while working in Edit Mode in a table. 
When tags are present, the tags Color attribute is not visible until you click out of the cell. 
For instance, if there is a Reference Identifier (RID) in the cell, its color only shows up if your 
cursor is not inside the cell. Also, the Merge and Unmerge features are not available from 
the Table menu unless two or more cells are selected, or the cell is a merged cell. 
 

 To make your table editing less complicated, we recommend you temporarily turn off View 
Tags. While this goes against the general recommendation of keeping tags visible while 
editing, it will make table editing easier. As soon as you complete your table editing, make 
sure to turn View Tags back on. Also, wait until all the text has been entered in the table 
before you begin adding your tags for References, Submittals, etc. 
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Using Revisions with Formatted Tables 
 

For the best experience editing Formatted Tables when you have Revisions turned ON, it is 
recommended that you first duplicate (copy) the Formatted Table including all applicable tags and 
paste the whole table below the original. Then, go back up to the original table and delete it in its 
entirety. This will mean you only have one set of DEL and ADD tags: DEL tags around the original table 
and ADD tags around the table you are editing. This makes the Formatted Table much easier to read 
as you are editing since multiple DEL and ADD tags won’t be inserted.  
  
To copy and paste information from one table into another, follow these steps: 
  

a. First, without clicking IN the table, just hover over the table and right-click. 
 

b. Next, choose Select Table. This selects/highlights the entire table, including the necessary table 
tags. 

 
c. Once the table is highlighted, right-click and select Copy to copy the table, then right-click and 

select Delete. The table gets redlined out and DEL tags are placed around it. 
 

d. Before moving your cursor, right-click and select Paste to paste a copy of the table 
immediately below the deleted one. The duplicate table is inserted with ADD tags around it. 
See example below: 

 

 
 

 Additional information and Formatted Table tips can be found under the Table Formatting 
and Editing Tips topic in this guide. 
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 For additional guidance, watch the Tables eLearning modules within Chapter 3 – Editing. 
 
 

Post Editing Tips 
 
After editing a Section, check the formatting by hiding all the on-screen elements that won’t appear in 
the printed document (e.g., Tags, Revisions, Notes, Formatting marks, etc.) and scan the entire Section 
for any missing or extra blank lines or spacing issues. 
 
NOTES: 
  

1. There should be one blank line between paragraphs. 
 

2. Before making any changes to adjust the formatting, don’t forget to turn View Tags back on to 
avoid inadvertently deleting content you did not mean to. 

  

https://www.wbdg.org/dod/specsintact/elearning
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Understanding Process and Print/Publishing 
 
One of the things that sets SpecsIntact apart from word processing programs are the automated 
features and reports that help assure the quality of your finished specifications. The QA tools and 
reports can help you find problems so that you can correct them before you publish the final product. 

Since the Process & Print/Publish option has multiple functions, you will need to become familiar with 
it as you work on your Job, and especially as you finish your text editing. 

You access it from the SI Explorer, by first selecting the Job, and then either right-clicking on it and 
selecting the Process and Print/Publish menu option or clicking on the Print/Publish button on the SI 
Explorer’s Toolbar. 
 

 
 
 
Print Processing Window and Option Tabs 
 
From the Print Processing window, you can choose from many options on the applicable tabs. 
 
While we have previously visited the Print Processing window, let’s look at some other important 
options and processes that you can access from this window beyond just printing. We’ll go through 
each tabbed screen and point out important things to understand about each of them. As you will see, 
selecting certain options on one tab can affect other options on another tab and produce different 
results when printing. 
 
Choose the printer from the drop-down Printer option. Unless you are printing to a physical printer, 
we recommend you select the SpecsIntact PDF printer for the best results. 
 
The following Printer and Print Processing window options and buttons are visible at the bottom of 
each of the Print Processing tabs: 
 

CHAPTER 5: PROCESS, PRINT AND 
PUBLISH 
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• Process and Publish: Processes and publishes the reports and/or Sections. 
 

 If printing to PDF, not only will SpecsIntact create the .PRN, .RPT, and .TOC files under 
that Job’s Processed Files folder, but it will also produce PDFs of the Sections, reports 
and Table of Contents files under the PDF Files folder. 

 
• Process Only: Runs and creates only the report files on the selected Section(s) and the Section 

(.PRN) print files, but it will not print or generate PDFs or Word versions of the Section(s) 
themselves. It ONLY creates print versions of the Sections, reports and/or TOC files. 

 
• Save Settings: Saves the choices made on the individually tabbed screens (except for Sections 

selected to be processed/printed) so that the next time the window is opened, the selections 
you save will be your new defaults on each tab. 

 
• Reset Settings: Resets any custom settings on all tabs to their default settings. 

 
• Cancel: Closes the Print Processing window. 

 
• Help: Takes you to Print Processing related help topics on the SpecsIntact Help webpage. 

 
 
Print Processing – Sections Tab  
 
The Sections tab has many options available when processing a Job. 
 
 
Select Sections 
 
Select to process All Sections or Some Sections. If you select Some Sections, you can select one or 
more Sections. 
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 All selected SpecsIntact Sections are processed, and the print (.PRN) versions of each Section 
are then generated and placed in the applicable Jobs Processed Files subfolder. These .PRN 
files are a copy of the edited Section (.SEC) files. SpecsIntact applies the selected print options 
and reconciliation processes to these instead of the actual editable Section (.SEC) files. This is 
how SpecsIntact keeps the editable Section (.SEC) files ‘in-tact’ during the reconciliation 
processes (e.g., when an unused Reference is stripped from the Reference Article of a Section). 
These changes are applied to the print (.PRN) version of the Sections, so if you were to open 
the print (.PRN) version of the Section, you would likely find the list of References much 
shorter than the editable (.SEC) version, as unused ones would have been stripped at time of 
print. 

 
Printing and Renumbering 
 

• Print/Process Sections: When checked, this means the Sections themselves will be processed 
and printed along with any reports, etc. that have been selected on the Reports tab. If you do 
not check this box, then only the selected reports, etc. will be processed based on the selected 
Sections, but not the Sections themselves. This option is checked by default. 

 
• Renumber paragraphs: When checked, SpecsIntact will automatically renumber the 

paragraphs within each Section per the edits made in them. This option is checked by default. 
 
Reconcile 
 
When running Print Processing on a Job, all three of the Reconcile processes (Addresses, References 
and Submittals) are checked by default. Although you are allowed to deselect them, it would be a rare 
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circumstance that you would not want all three of these to process every time you Print/Publish the 
Job. All three (3) of these reconciliation processes are checked by default. 
 
Address Reconciliation 
 
Reconciles the 01 42 00 Sources for Reference Publications (Address) Section by removing any 
Reference Organizations from this Section that were not used throughout the Job, leaving behind only 
those Reference Organizations you have used. 
 

 The 01 42 00 Section is required in every project and is added by default when you create a 
new Job. 

 

 Additional information on Address Reconciliation can be found under the Section 01 42 
00 (Address Section) and the Address Reconciliation and Verification Report topics in this 
guide. 

 
Reference Reconciliation 
 
Reconciles Reference Standards within each Section by removing any Reference Standards from the 
‘1.x REFERENCES’ Article of the Section that are no longer being used elsewhere in the Section due to 
being edited out. This means you end up with just a list of the Reference Standards you cited in the 
Section in the Reference Article of each of your Sections. 
 

 Additional information on Reference Reconciliation can be found under the Reference 
Reconciliation and Verification Report topic in this guide. 
 

Submittal Reconciliation 
 
Reconciles the 01 33 00 Submittal Procedures Section by removing any unused Submittal Descriptions 
(SD-01 through SD-11) from this Section that were not used throughout the Job, leaving behind only 
those Submittal Descriptions that were cited.  

 

 The 01 33 00 Section is required in every project and is added by default when you create a 
new Job. 

 

 Additional information on Submittal Reconciliation can be found under the Section 01 33 
00 Submittal Procedures topic in this guide. 
 

 For additional guidance, watch the Section Tab eLearning module within Chapter 4 – Process 
and Print/Publish. 
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Print Processing – Reports Tab 
 
The Reports tab of the Print Processing screen allows you to select any or all 10 available SpecsIntact 
reports to process and/or print for the selected Sections. 
 
 

Report Selection 
 
Check the boxes beside the reports you 
wish to produce. 
 
The top five (5) Verification reports are 
checked by default on all new Jobs and 
are generated when you select either 
the Process & Publish or Process Only 
button. 

 
 

 
 

NOTE: If you choose the Process Only option, you get a warning: 
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 For additional guidance, watch the Reports Tab eLearning module within Chapter 4 – Process 
and Print/Publish. 

 
 
Report Storage and Generation  
 
As reports are generated, they are placed in the applicable Job subfolder, based on what type of file 
they are. Whether you click the Process Only button or the Process & Print button, the software will 
always create the processed files (.PRN & .RPT) and place them in the Processed Files folder under the 
Job. 
 

1. Processed Files folder: This Job subfolder is created the first time you print/publish your Job 
files. 

 

• All Print (.PRN) files and Report (.RPT) files that are generated during publishing and/or 
processing are saved in the Job’s Processed Files subfolder as shown below: 
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PDF and Word files are only generated when you click the Process & Print button and are placed in 
the PDF Files and Word Files folders, respectively. 

 
1. PDF Files folder: This Job subfolder is created the first time you print/publish your reports and 

Section files to PDF. To publish to PDF, you must click the green Process & Publish button. 
 
• All generated PDF files (Sections and reports) are saved in the PDF Files subfolder as shown 

below: 
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2. Word Files folder: This Job subfolder is created the first time you print/publish your Section 

files to Word. To publish your Sections to Word, you must click the green Process & Publish 
button. 
 
• All generated Section Word files are saved in the Word Files subfolder as shown below: 

 

 
 

 For additional guidance, watch the PDF Publish Tab and Word Publish Tab eLearning modules 
within Chapter 4 – Process and Print/Publish. 

 

 Note that the Submittal Register (e.g., REGISTER.PDF) report can only be printed as a PDF 
file. The Process Only button will not generate this report. 
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Verification Reports 
 
The following QA reports point out errors in your project. You should fix all identified issues by the 
final phase of the project to make sure your Job information is accurate and complete. 
 
 
Address Verification 
 
The Address Verification (ADDVER.RPT) lists any Reference Organizations that appear in a Job 
Section's Reference Article without a matching listing in either the 01 42 00 Sources for Reference 
Publications (Address) Section or the Supplemental Reference List (SRL). 
 

 Address Organizations are recognizable by the Organization (ORG) tags that surround them 
(e.g., <ORG>AMERICAN NATIONAL STANDARD INSTITUTE (ANSI)<ORG>). 
 

  Additional information on Addresses can be found under the Section 01 42 00 (Address 
Section) and Address Reconciliation and Verification Report topics in this guide. 

 
 For additional guidance, watch the Address Verification Report eLearning module within 
Chapter 6 – Correcting QA Report Errors and Discrepancies. 

 
 
Reference Verification 
 
The Reference Verification provides results in two distinct reports for easier review: 

 
1. Generates the Reference Verification Report (REFVER.RPT). This report lists any missing 

Reference Standards from all Sections that were cited in the text but are not also listed in the 
Reference Article along with their corresponding organization date and title details. 

 
2. Generates the Reference Title Discrepancies Report (TTLDIFFS.RPT). This report lists Reference 

Identifiers (RIDs) with conflicting Reference Titles in two or more Reference Article Sections 
within the Job. 
 

 References are recognizable by the Reference Identifier (RID) tags that surround them and 
their purple/pink color (e.g., <RID>ANSI C31.9<RID>). 

 

  Additional information on References can be found under the Section 01 42 00 (Address 
Section) and Reference Reconciliation and Verification Report topics in this guide. 
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 For additional guidance, watch the Reference Verification Report eLearning module within 
Chapter 6 – Correcting QA Report Errors and Discrepancies. 

 
 
Submittal Verification 
 
The Submittal Verification (SUBVER.RPT) lists any Submittal Items from all Sections that were cited in 
the text but are not listed in the Submittal Article and vice-versa. The bottom Section of this report 
indicates any SD-XX Submittal Descriptions that do not match up to the standard SD-01 through SD-11 
that are listed in the 01 33 00 Submittal Procedures Section. 
 

 Submittals are recognizable by the Submittal (SUB) tags that surround them and their blue 
color (e.g., <SUB>SD-03 Product Data<SUB> or Submittal Item; <SUB>Formwork 
Materials</SUB>). 
 

  Additional information on Submittals can be found under the Submittal Reconciliation and 
Verification Report topic in this guide. 

 
 For additional guidance, watch the Submittal Verification Report eLearning module within 
Chapter 6 – Correcting QA Report Errors and Discrepancies. 

 
Bracket Verification 
 
The Bracket Verification (BRKTVER.RPT) lists any outstanding [bracketed options] alerting specifiers to 
go back and make the necessary bracketed choices indicated. 
 

  Additional information on Bracketed Options can be found under the Bracket Replacement 
Tool topic in this guide. 

 
 For additional guidance, watch the Bracket Verification Report eLearning module within 
Chapter 6 – Correcting QA Report Errors and Discrepancies. 

 
Section Verification 
 
The Section Verification (SECTVER.RPT) lists any Sections that were cited in the text that are not 
included in the Job/Project. 
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  Additional information on Section References can be found under the Section Verification 
Report topic in this guide. 

 
 For additional guidance, watch the Section Verification Report eLearning module within 
Chapter 6 – Correcting QA Report Errors and Discrepancies. 

 
 
Information Only Report Lists 
 
The following lists are just for your information. They help you find where things like References and 
Submittals are located, but they don't mean there is anything wrong with your project that needs 
fixing. 
 
Attachment List 
 
The Attachment List (ATTACHMT.RPT) lists all the Attachments cited in the Job, followed by the 
Section number along with the Subpart numbers where they can be found. This also serves as a 
notification for the specifier to remember where to manually insert these external attachments in the 
final/complete project. NOTE: This is an information-only report. 
 
Reference Location List 
 
The Reference Location List (REFKYLIST.RPT) lists all the References cited in all the Job Sections and 
Notes along with the Subpart numbers where they can be found. NOTE: This is an information-only 
report. 
 
Submittal List 
 
The Submittal List (SUBMLST.RPT) lists all the Submittal Descriptions (SD-01 through SD-11) cited in all 
the Job Sections along with the Subpart numbers where they can be found. NOTE: This is an 
information-only report. 

 
Submittal Register 
 
The Submittal Register Report (REGISTER.PDF) can only be produced when published to PDF. So, 
when generated, it is published and placed in the Jobs PDF Files folder. This report (produced in 
spreadsheet-like format) lists the materials, products and items for each Submittal cited in the Job, as 
well as the Section and Subpart number where each of these is located. Additionally, any required 

https://www.wbdg.org/dod/specsintact/elearning


 
 

82     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

Government or Reviewer codes are also displayed in the Classification column next to the applicable 
submittal item. 
 
Test Requirements List 
 
The Test Requirements List (TSTRQLST.RPT) lists all the Test Requirements cited in all the Sections, 
along with the Section and Subpart numbers in which they can be found. NOTE: This is an information-
only report. 
 
 
Print Processing – Reports Tab/Table of Contents 
 
The Section Table of Contents and the Project Table of Contents section of the Reports tab allow you 
to select what kind of Section and/or Project TOC you want to publish. The default is no TOC options 
are selected for either type of TOC. 
 

• Section Table of Contents 
 

 
 

o Include with scope: The scope of the Section can be found in the very first informational 
note at the top of every UFGS Master Section as shown below. The scope information is 
identified by the Scope (SCP) tags that surround the applicable text. 

 

 
 

If you choose to include the scope in the Section TOC, the scope note from the Section is 
inserted in the Section TOC below the Section Date information as highlighted below: 
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o Include without scope: The scope note is not included anywhere in the published Section 
TOC.  

 
o Combine Sections and Section tables of contents: If you choose this option then the 

processed (.PRN) Sections and the published (.PDF) Sections will do just that and place the 
selected TOC at the beginning of each Section instead of publishing the TOC as a separate 
file. 

 
• Project Table of Contents 

 

  
 

o Include with scope: Example of Project Table of Contents with Scope Note shown below: 
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o Include without scope: Example of a Project Table of Contents without Scope Note shown 
below: 

 

 
 

o Include Division 00: If checked any Division 00 Sections (documents) in the Job will also be 
included in the Project Table of Contents. 
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o List any unused divisions in the project table of contents: If checked, then all unused UFGS 
Master Divisions will still be listed in the Project Table of Contents. 

 
 For additional guidance, watch the Reports Tab eLearning module within Chapter 4 – Process 
and Print/Publish. 

 
 
 
Print Processing – Other Documents Tab  
 
On the Other Documents tab, there are settings you can choose to apply to any documents contained 
in the Job. For instance, a cover page for the project. 
 

 
 
NOTE: If the Job does not contain any documents, all the options on this Print Processing window are 
not applicable and therefore will be unavailable. 
 
 
Print Processing – Options Tab  
 
On the Options tab, the Show section is one of the most important group of options on this tab. This 
is where you choose what Section components you want to show when you print the Section(s). 
 
For detailed recommendations on what options to choose when printing or publishing Sections to be 
marked up for the very first time, please refer to the Print Recommendations for Sections Prior to First 
Markups topic in this guide. The recommended options are shown/checked below: 
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The logic behind selecting these print options for the first round of edits are listed below: 
 

• Section Dates: Printing with the Section Dates assures the specifier they are starting with the 
latest version of the Section to begin the project. 

 
• Notes: Printing with the Notes showing is important because they often contain valuable 

information that assists the specifier in marking up the text accurately. 
 

 Always initially print with Specifier Notes showing when printing Job Sections for a 
new project. 

 
• Color (when using a color printer): Printing or producing the PDF files showing the colors 

makes the SpecsIntact components stand out and they become easily recognizable as 
References, Submittals, Section References, Tailoring Options, English measurements, etc. 

 
• Tailoring tags (when hiding tags): When printing with colors, Tailoring Options are easy to 

recognize because they are all colored teal. However, you cannot tell what the specific Tailored 
Option text is designated as unless you select this option and print the Tailoring tags (e.g. 
ARMY, NAVY, AIR FORCE). 

 

 It is recommended to print with both the Color (when using a color printer) and 
Tailoring tags (when hiding tags) showing when printing Job Sections for almost all 
phases of a project, except possibly the final submittal phase. This aids the specifier 
in being able to quickly identify References, Submittals, Section References, and 
specific Tailoring Options at a glance. 
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• Units of Measure: Select the applicable unit of measure (English, Metric or Both) for the 
current project to include in the printed/published Sections. Only the selected option will be 
printed/published, the other unit of measure will be hidden unless you choose Both. 

 
• Revisions: When printing, this option will produce the printed/published Sections showing all 

Revisions (additions and deletions). In early submittal phases, this is likely to be a requirement 
until the project is finalized. 

 
• Tags: Print showing all tags in the Section(s). This may be helpful to pinpoint possible tagging 

errors. 
 

 When printing or publishing Sections for later submittal phases, you may want to 
adjust these options accordingly. For instance, after the first few rounds of edits 
you may not want to include the Sections Dates or Notes in the printed or 
published Sections as the specifier likely doesn’t need to see this information at 
that point. 

 
 For additional guidance, watch the Options Tab eLearning module within Chapter 4 – Process 
and Print/Publish. 

 
 
Print Processing – Header/Footer Tab 
 
On the Header/Footer tab, SpecsIntact offers you the options of having a maximum of two lines in 
both your Header and Footer for printed and/or published Sections, Table of Contents and reports. 
Additionally, you can choose where that information is printed on the applicable Header or Footer line 
at the Left/Right/Center alignment location. 
 
SpecsIntact can automatically grab and insert information from any of the fields of the Properties for 
Job window shown below: 
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• Header and Footer: These fields are listed under the Variables pane of the Header/Footer tab. 
You can also insert page and Section Numbers in a selected Header or Footer field. 

 

 
 

To add a variable or enter text of your own in the Header or Footer, simply click in the location 
field you want the text to appear. Next either enter text or click on a variable to grab from the 
Properties of Job window, then click the Add Variable button to insert it. You can also mix typed 
text and variables, as shown in the first line of the Footer in the above screenshot where the word 
SECTION is typed and the variable to grab the applicable Section Number {section} is inserted right 
after, then the word Page is typed and the variable for the Page Number {page} is inserted directly 
after it. 

 
The Header and Footer variables inserted and typed in as shown above appear as follows when 
the Section is printed to PDF or Word. 

HEADER 

 
 

The variable {jobname} grabbed the name of this training Job: MYJOB (this will be whatever your 
actual Job name is). 
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FOOTER

 
 

The {section} variable grabbed the applicable Section Number (01 78 23) and inserted it. The 
{page} variable inserted the applicable page number on each page of the Section. Also note how 
other variables were grabbed from the Properties for Job window and the appropriate 
information was inserted in the Header and Footer in the format of the selected variable (e.g., 
02/04/26 {mm/dd/yy} in the Header Center field, UFGS NOV 2025 {source} in the Lower Left 
Footer field, and the 123456 {contract} information in the Lower Right footer field). 

 
• Reports and Table of Contents: The same Header and Footer text can be applied to Reports and 

TOC files by checking that option under this section on the bottom of the Header/Footer tab: 
 

 
 

o With only the Use the above headers and footers for reports and project TOCs option 
checked, all the Header and Footer information selected above will be applied to those files 
with the Document file name inserted in lieu of a Section Number. 
 

o The second option Use document title for first footer line is only available if the first option is 
selected. This option will then use the report or TOC name in lieu of the Footer fields and will 
ignore the Left and Right Footer fields. The second Footer line remains the same. 

 
 For additional guidance, watch the Header/Footer Tab eLearning module within Chapter 4 – 
Process and Print/Publish. 

 
 
Print Processing – PDF Publish Tab  
 
There are many options available on the PDF Publish tab when you opt to publish your Section(s) to 
PDF. 
 

 Section PDF files are generated from the processed .PRN versions of each Section rather 
than the original .SEC files. During the Reconciliation processes, the software duplicates the 
.SEC files into a .PRN format to apply automated changes based on your Job Section edits. 
Consequently, only the .PRN files contain the final, reconciled data required for an accurate 
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PDF. If you open the .SEC file, it will still be intact as you last saved it. For example, all 
References will still be listed in the Reference Article even if some were stripped out for 
non-use in the .PRN/PDF version of the Section. 

 
• Publish to PDF: First you must check this option. No other options will be available for selection 

unless you check this. 
 

 Even if this top option is checked, some of the options are still grayed out depending 
on what additional options you select. 

 

 
 
• Save copies to PDF subfolder: This option is only available when printing a Job and allows you to 

process a set of PDF documents that correspond to the Review Status/Amendment Level chosen 
from the Schedule Tab of the Properties for Job window (shown below) and saved in a separate 
folder with that review status folder name under the PDF Files folder. 
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• Save copies to this folder: When publishing to PDF, you can browse and save copies of the PDF 
documents to an alternative location outside of the Working Directory. This option can be used to 
promote team collaboration while also publishing and leaving the original PDF documents in their 
default location within the SpecsIntact Working Directory. 

 

 
 

 This ‘browsed to’ folder location is temporary and will not be retained or saved, even if 
you click the Save Settings button. 

 
• Retain existing PDF files unless replaced with newer versions: This option prevents the system 

from automatically deleting all existing PDF files in the destination folder or subfolder when new 
PDF files are generated. Any existing PDF files in the folder or subfolder that have the same names 
as ones being generated will be replaced with the newly generated files unless this option is 
selected. 

 

 
 

• Bookmark Sections: This option creates bookmarks in TOC format in the PDF of the Sections, with 
an expandable outline that contains links to the Parts and Subparts that allows you to quickly jump 
to whichever one you click on just as in the SI Editor’s Navigator. 

 

 
 

• Add Section number to Section bookmark: This option will add the Section Number to the Section 
bookmarks. 

 
• Add Section number to Section table of contents bookmark: This option is only available when 

either of the Section Table of Contents options (with or without scope) on the Reports tab of the 
Print Processing window is selected: 
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 If neither of the Section Table of Contents options from the Reports tab shown 
above is checked, this option will be grayed out on the PDF Publish tab. 

 
• Combine processed Sections into one PDF document (publish.pdf): This option creates one PDF 

document containing your entire Job or selected Sections. If you have selected the Project Table 
of Contents from the Reports tab, you will have the two following options shown below: 

 

 
 

o Include Project table of contents in combined PDF document: This option will add the Project 
Table of Contents (with or without scope, as selected on the Reports tab) as the first page(s) in 
front of all the specification Sections in one large, combined PDF document (PUBLISH.PDF). 

 

 
 

o Create a separate PDF file for the Project table of contents: This option will create a separate 
Project Table of Contents (with or without scope, as selected on the Reports tab shown on the 
screenshot above). 

 
1. If the Include with scope option is selected, the file name generated will be PROJSCP.PDF. 

 
2. If the Include without scope option is selected, the file name generated will be 

PROJECT.PDF. 
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• Use GhostScript for publishing [requires separate installation]: SpecsIntact fully supports 
GhostScript as a third alternative for publishing to PDF. As noted, a separate installation is 
required for GPL GhostScript. If it is not installed, this option is grayed out. Additionally, the 
SpecsIntact PDF printer must be installed and selected to publish using GhostScript. 

 

 
 

Once the PDF Section(s) have been published they are accessible under the applicable PDF Files 
folder or alternate selected PDF folder: 

 

 
 

 There is NO way to bring a PDF Section back into SpecsIntact, even if the PDF file was 
originally created in SpecsIntact. 

 
 For additional guidance, watch the PDF Publish Tab eLearning module within Chapter 4 – 
Process and Print/Publish. 

 
 
Print Processing – Word Publish Tab 
 
SpecsIntact provides an option to publish your Sections to Microsoft Word from the Word Publish 
tab. 
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• Publish Sections to Word: Section files will be published with all your previously selected options 
from the other tabs. 

 

  
 

 SpecsIntact converts Sections first to PDF format. Those files are then converted to Word 
files. This information is noted in a popup window as soon as you click on the Word Publish 
tab. 

 

 
 

 If in the future you do not want to see this popup again, you can place a check in the 
Don’t show this again checkbox. 

 
1. Click OK to open the Word Publish tab and then place a check in the Publish Sections to 

Word option to proceed with the conversion of Sections from PDF to Word. 
 

2. Click the Process & Publish button. The software begins processing the Job Sections and then 
switches over to the PDF Publish tab and begins to convert your Section files to PDF files 
based on the pre-selected options: 
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Publishing Process 
 

1. Once the PDF files are generated, the system flips back to the Word Publish tab. 
 
2. The bottom pane of the Word Publish tab displays a list of the converted PDF files and 

immediately starts to convert those to Word format. The files are checked off as they are 
converted. The green status bar shows the progress of this final conversion process: 

 

 
 

3. Once the Word files have been published, the newly converted Word files are accessible under the 
Word Files folder under the Job name. 
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 There is NO way to convert a Section from Word back to SpecsIntact, even if the Word file 
was originally created using this process. 

 

 For additional guidance, watch the Word Publish Tab eLearning module within Chapter 4 – 
Process and Print/Publish. 

 
You should now be familiar with how to navigate all the tabs and options in the Print Processing 
window and be able to find the processed and published files and know the difference between them. 
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Cleaning Up SpecsIntact Reports 
 
All the available SpecsIntact reports were identified in the Print Processing – Reports Tab topic in this 
guide. This topic will cover how to open, read and correct the discrepancies or errors identified on 
those reports. 
 
All SpecsIntact reports are generated with an .RPT file extension and are placed in the Processed Files 
folder. 
 

 
 

1. Viewing and fixing any errors or discrepancies on the SI reports is simple. Just double-click any 
report file (e.g., SECTVER.RPT) to open it. The Section Verification Report is shown as an 
example below: 

 

 
 

2. Once the report is open, you can review all discrepancies identified during report generation, 
including their specific Section and Subpart locations. To navigate directly to an issue, 
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double-click the Section Number on any line item; SpecsIntact will open the relevant Section 
and position the cursor at the exact location identified in the report. 

 

 
 
This method allows you to quickly correct the Section containing the discrepancy, save the Section, 
close it, and move on to the next one. 
 

 When a Section is double-clicked and opened from a report, the report remains active in 
the background of the SI Editor. By using the smaller 'x' to close only the current Section - 
rather than the main application (larger) 'X' - you can easily return to the report and 
move on to the next item. 

 

 
 
 
Address Reconciliation and Verification Report 
 
The UFGS Section 01 42 00 Sources for Reference Publications (Address Section) is the key to the 
Address Reconciliation process, and the address verification information is reported on the Address 
Verification Report. 
 
 
Address Reconciliation Process 
 
As mentioned earlier in this guide, all the Reference Organizations that are used throughout the whole 
UFGS Master are listed in Section 01 42 00 Sources for Reference Publications (Address Section). The 
purpose of running the Address Reconciliation process is for this Address Section to end up only listing 
the Organizations that are being used in the current Job. This is what the Address Reconciliation 
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process does. It scans every Section in your Job and strips out any organization information that 
wasn’t used in any of your project Sections. 
 
There are a couple of things to know to get the correct results out of this process: 
 

a. When you go to print/publish your Job, All Sections is selected by default, unless you had a 
single or set of Sections selected when you open this window. Additionally, the Addresses, 
References, and Submittals options under the Reconcile section of this window are also 
selected as shown below: 
 

 
 

b. If the Addresses option is not selected, the Address Reconciliation process will not run, and the 
entire 01 42 00 Address Section will be printed. 

 

 NEVER delete Reference Organizations from the 01 42 00 Address Section. This is 
done automatically based on the Section edits made in the entire Job when the 
Reference and Address Reconciliation processes are run. 

 
 
Address Verification Report 
 
It is very important to make sure that any newly added Reference Organization is already present in 
the 01 42 00 Address Section of your Job. If not, it must be added. Most Reference Organizations are 
already included in this Section, but on the occasion a new Organization needs to be added, it is 
imperative to have the most up-to-date and complete information. 
 
To verify that there are no missing addresses from the 01 42 00 Address Section, you should run the 
Address Verification Report on the Job. 
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Cleaning Up the Address Verification Report 
 
When an address is missing from the 01 42 00 Address Section, the Address Verification Report will 
tell you the exact Reference Organization that is missing and what Section it was found in as shown 
below. 
 

 Note the HINT on the report informs you that you can double-click on the Section 
Number to open that Section. Additionally, it will take you directly to the place in the 
Section where the unverified Reference Organization is located so you can verify it. 
 

 
 
If you feel the information in the report is incorrect and that this organization’s address is in fact 
already included in the 01 42 00 Address Section, you should open that Section and search for that 
organization. If you do find the applicable organization, it is likely that it is just a keying error when 
you inserted it in the Reference Article of that Section. Remember, if the information within the ORG 
tags in the Section does not EXACTLY match what is in the 01 42 00 Address Section, SpecsIntact will 
not consider them a match and will include them in this report. To remedy this, simply copy the 
organization name <ORG>CSA GROUP (CSA)</ORG> from the 01 42 00 Address Section and paste it 
inside that organization’s ORG tags in the actual Section. Save the Section and run the report again to 
verify it is now a match. 
 

 
 

If the organization is really missing from the 01 42 00 Address Section, it would need to be added to 
the Section, including all its applicable information within the correct REF, ORG, and OAD tags. 
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To add a new Reference Organization Address to the Address Section, double-click on the 01 42 00 
Address Section to open it. Copying and pasting an existing Reference Organization and using it as a 
template for the new Reference Organization is the most efficient way to insert it. 
 

1. First, scroll down to where the new Reference Organization should be inserted (in alphabetical 
order - by name, not acronym). Then copy the organization above or below where you want to 
insert the new one and highlight the whole organization including both the beginning and 
ending REF tags as shown below: 

 

 
 

2. Use your preferred method to copy the highlighted tags and text, then place your cursor after 
the ending </REF> tag of the organization above where you want to insert your new 
organization and paste it there. 
 

3. Lastly since it’s being used as a template, type in the new information over top of the copied 
information, within the applicable tags: 
 

 
 

4. Repeat steps above for each new Reference Organization that needs to be added. 
5. Click Save then Close. 
6. Re-run the Address Verification Report to verify the report is now clear. 

 

  Additional information on Reference Addresses can be found under the Section 01 42 00 
(Address Section) topic in this guide. 

 
 For additional guidance, watch the Address Verification Report eLearning module within 

Chapter 6 – Correcting QA Report Errors and Discrepancies. 

https://www.wbdg.org/dod/specsintact/elearning
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Reference Reconciliation and Verification Report 
 
The Reference Reconciliation function automates the maintenance of the Reference Article in each 
Job Section. During this process, the software removes Reference Identifiers (RIDs) from the 
Reference Article that are no longer cited due to Section edits, ensuring the reference list in the .PRN 
file remains concise and accurate. If a RID is deleted from the text, the software automatically 
removes the corresponding entry from the Reference Article. Conversely, while the Reference 
Reconciliation process handles RID removals, the Reference Verification Report identifies any missing 
RIDs that need to be added to the Reference Article. 
 

  The Reference Reconciliation process runs on each individual Section within a Job and removes 
unused RIDs from each Section. This is different from both the Address Reconciliation and 
Submittal Reconciliation processes. Those functions scan all the Sections in a Job and then 
remove unused elements (Addresses or Submittals) from the applicable 01 42 00 Address 
Section or the 01 33 00 Submittal Procedures Section, respectively. 

 
 
Reference Reconciliation Process 
 
The Reference Reconciliation process eliminates the need to manually delete any Reference standards 
from the Reference Article of any Section in a Job by removing any deleted (edited out) References 
Identifiers (RIDs) automatically. 
 

  The Reference Reconciliation process occurs during the print/publish cycle. These changes are 
applied exclusively to the output versions of the Sections (.PRN, .DOC, and .PDF) and do not 
modify the source .SEC files. Consequently, opening a .SEC file will still reveal the original RIDs, 
even after reconciliation has been performed. 

 

 NEVER manually delete Reference Identifiers from Reference Article of any Section in a 
Job. This is wasted effort since SpecsIntact will strip out any unused ones during the 
Reference Reconciliation process for you. 

 
 
Reference Verification Report 
 
Reference Identifier (RID) tags must be placed around every Reference ID and tagged in the Section’s 
text outside the ‘1.x REFERENCES’ Article as well as be included inside the Reference Article. The 
Reference Verification Report verifies that this is true and if there are RIDs in the Section text missing 
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from the Reference Article. If the RID (e.g., ASTM E2166) is not there, it will be listed as an Unresolved 
Reference on this report. 
 

 
 

 The Reference Verification Report generates two separate files: the primary Reference 
Verification Report (REFVER.RPT) and the Reference Title Report (TTLDIFFS.RPT). To 
resolve project discrepancies or errors, you should focus specifically on the REFVER.RPT 
file. 

 
 
Cleaning Up the Reference Verification Report 
 
Double-click on the Reference Verification Report (REFVER.RPT) to open it. If no issues were found in 
any Section, the report will note ALL REFERENCES HAVE BEEN VERIFIED. 
 
The Unresolved References portion of this report lists RIDs that you’ve added in your text but forgot 
to include in your Reference Article. You’ll need to add these back into the Reference Article using the 
Reference ID (RID) and Reference Title (RTL) tags, making sure to include the title and the date. 
 

 Note the HINT on the report informs you that you can double-click on the Section Number 
to open that Section. Additionally, it will take you directly to the place in the Section 
where the unverified Reference ID is located so you verify it and then add it to the 
Reference Article as necessary. 
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  Additional information on inserting Reference IDs and Addresses in a Section can be found 
under the Reference Wizard topic in this guide. 

 
Reference Verification Report (Lower Section) 
 

The lower portion of the Reference Verification Report lists any Unused References. However, this 
portion of the report only gets populated if the References checkbox option under the Reconcile 
section in the Print Processing window is not checked when you process the report. NOTE: All 
reconciliation processes are checked by default here. 
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Any References listed on the second part of the Reference Verification Report do not indicate a 
problem in the Job. It is for information only as it just lists unused References that were likely in 
paragraphs that were purposely edited out. 

 
 For additional guidance, watch the Reference Verification Report eLearning module within 

Chapter 6 – Correcting QA Report Errors and Discrepancies. 
 
 
Submittal Reconciliation and Verification Report 
 
The Submittal Reconciliation function is processed during the print/publish phase of the project to 
remove any unused Submittal Descriptions (SD-01 through SD-11) from the 01 33 00 Submittal 
Procedures Section of your Job. Once that process finishes, the Submittal Verification Report 
identifies any mis-matched Submittals within each Job Section. 
 
 
Submittal Reconciliation Process 
 
The Submittal Reconciliation process is the third and final Reconciliation Process in SpecsIntact. This 
process compares the Submittal Descriptions used in each of the project Sections in the Job to the 
eleven (11) standard Submittal Descriptions listed in the ‘1.2.1 Quantity of Submittals’ sub-paragraph 
of the 01 33 00 Submittals Procedures Section in the Job. The only valid Submittal Descriptions are 
listed below: 
 

SD-01 Preconstruction Submittals SD-07 Certificates 
SD-02 Shop Drawings SD-08 Manufacturer's Instructions 
SD-03 Product Data SD-09 Manufacturer's Field Reports 
SD-04 Samples SD-10 Operation and Maintenance Data 
SD-05 Design Data SD-11 Closeout Submittals 
SD-06 Test Reports  

 
When Submittal Reconciliation is run on the Job, any of the SD-01 through SD-11 Submittal 
Descriptions that were NOT used in the Job, are stripped from the ‘1.2.1 Quantity of Submittals’ 
subpart of the 01 33 00 Submittals Procedures Section leaving only the Submittal Descriptions that 
were cited in the Job. 
 

  The Submittal Reconciliation process is run on the Job during the print/publish process. This is 
why the Submittal Reconciliation process changes only appear in the output versions of 
Section 01 33 00 Submittal Procedures (.PRN, .DOC and .PDF), NOT in the original .SEC files. 

https://www.wbdg.org/dod/specsintact/elearning
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Therefore, when the .SEC version of Section 01 33 00 is opened, all the original SD-01 through 
SD-11 Submittal Descriptions will still be there. 

 

 The Submittal Reconciliation process eliminates the need to manually delete any Submittals 
Descriptions from the Section 01 33 00 Submittal Procedures. 

 
Submittal Verification Report 
 
To verify that there are no missing or unverified Submittal Descriptions (SD-) or Submittal Items, you 
should always run the Submittal Verification Report on your Section. This report will give you an error 
if a Submittal Description noted in a Section is not found in the 01 33 00 Submittal Procedures Section. 
It will also alert you if you have used a Submittal Item in the Submittal Article of the Section, but it is 
not found elsewhere in the text of the Section and vice versa – as this is a standard requirement. 
 
Once processed, the Submittal Verification Report will be located under the Job’s Processed Files 
folder. The report file’s name is ‘SUBMVER.RPT’. Double-click to open and view the report. There are 
two parts to this report: (1) Section Submittal Discrepancies and (2) Discrepancies Between 
Submittal Articles and Submittal Procedures Section. Both are explained in detail within this topic. 
 
 
Cleaning Up the Submittal Verification Report 
 
Double-click on the Submittal Verification Report (SUBMVER.RPT) to open it. If no issues were found 
in any Section, the report will note ALL SUBMITTALS HAVE BEEN VERIFIED. 
 
Section Submittal Discrepancies 
 
The top portion of the Submittal Verification Report focuses on Section Submittal Discrepancies in 
each Section and lists any Submittal Items that do not match up within a Section. If there are no 
discrepancies, this part of the report will be blank. 
 
If there are discrepancies, they will be listed as shown in the example below: 
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 Note the HINT on the report informs you that you can double-click on the Section 
Number to open that Section. Additionally, it will take you directly to the place in the 
Section where the unverified Submittal Item is located so you verify it and address it as 
necessary. 

 

 Pay close attention to the highlighted wording above on this part of the report! 

 
• Submittal was not found in the Submittal Article: 

 
The first error is telling you that the Submittal Item – Training Video Recording - was not found in 
the Submittal Article. This means that it is noted in Subpart 3.1.4 of the Section, but it is NOT listed 
in the Submittal Article as it is required to be. To correct this discrepancy, either the Submittal 
Item must be deleted from Subpart 3.1.4, or it must be added under the applicable SD-XX 
Submittal Description in the Submittal Article. Either of these options will clear up this error. 

 
• Submittal was not found outside the Submittal Article: 
 

The second error is indicating the exact opposite is true for this Submittal Item – Record Drawings 
and Utility Systems. This instance is to inform you that this Submittal Item was not found outside 
the Submittal Article. This means it is listed in the Submittal Article, but it is not noted anywhere 
else in the Section, as is required. In this case, it should either be deleted from the Submittal 
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Article (if it is not needed), found and tagged as a Submittal (if it is needed), or added elsewhere in 
the text (if it is needed). 

 

 In summary, if you have a Submittal Item listed in the Submittal Article, then it must be 
addressed somewhere else in the Section - and vice versa! 

 

  Additional information on inserting Submittal Descriptions and Items in a Section can be 
found under the Submittal Wizard topic in this guide. 

 
Discrepancies Between Submittal Articles and Submittal Procedures Section 
 
The bottom portion of the Submittal Verification Report focuses on Discrepancies Between 
Submittal Articles and Submittal Procedures Section. This part of the report lets you know if a 
Submittal Description that is listed in the Submittal Article of the Section does NOT match any of the 
standard eleven Submittal Descriptions (SD-01 through SD-11) in the 01 33 00 Submittals Procedures 
Section. If an inserted one is not found, it is listed in this part of the report. If there are no 
discrepancies, this part of the report will be blank. 
 

 
 

To clear up any discrepancies in this report, you must edit the Submittal Description to exactly match 
one of the standard Submittal Descriptions (SD-01 through SD-11). In this example, ‘SD-12 Closeout 
Submittals’ should be corrected to ‘SD-11 Closeout Submittals’. 
 

  Additional information on valid Submittal Descriptions can be found in the chart under the 
Submittal Reconciliation Process topic in this guide. 

 
 For additional guidance, watch the Submittal Verification Report eLearning module within 

Chapter 6 – Correcting QA Report Errors and Discrepancies. 

https://www.wbdg.org/dod/specsintact/elearning
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Section Verification Report 
 
The Section Verification Report aids in alerting you if a UFGS Master Section is cited in the text of one 
or more of your project Sections but it is NOT included in your Job. This report helps to ensure that 
nothing is missing in your project that might be important to include from another UFGS Master 
Section. 
 
Here is an example of a Section Reference from within UFGS Section 01 78 00: 
 

 
 
Section 01 78 00 Closeout Submittals is referenced (cited) in Subpart 1.6.2.1 of Section 01 78 23, but it 
is not included in our project. 
 

  There are SRF tags surrounding all the Section Numbers within a specification Section. This is 
how SpecsIntact can report any discrepancies when the Section Verification Report is 
generated when the Job is print/published. This is why it’s important when inserting a new 
Section Reference into a paragraph that you insert the Section Number exactly as it should be 
formatted and insert SRF tags around it. 

 
 
Cleaning Up the Section Verification Report 
 
To clean up the Section Verification Report you first need to determine whether the Section that is 
being cited/referenced really has information that directly pertains to this project and whether it 
needs to be added to the Job. This is something the specifier will have to determine. Which direction 
is decided upon determines how the Section Reference discrepancies will be resolved and therefore 
be removed from the Section Verification Report. Here is an example of this report: 
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Note the Section Reference we pointed out at the beginning of this topic is highlighted above. Within 
Section 01 78 23 that is included in this Job, Section 01 78 00 is cited/referenced in paragraph 1.6.2.1. 
This report points out that we have referenced it, but that it is not included in our Job. 
 

 Note the HINT on the report informs you that you can double-click on the Section 
Number to open that Section. Additionally, it will take you directly to the place in the 
Section where the unverified Section Reference is located so you verify it and address it 
as necessary. 

 
• Option 1: Keep the Section Reference in the sentence it is cited in. 

 
Solution: Add the Section to the Job. This will resolve the discrepancy and remove that instance 
from the report. 

 

 CAUTION: Before adding the Sections listed in this report to your Job, consider the potential 
impact on your project scope. Each added Section likely contains its own references to 
additional Sections. Adding them without verification may cause the list of missing Sections 
to expand rather than decrease. 
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• Option 2: Delete the sentence the Section Reference is referenced in. 
 
Solution: This will resolve the discrepancy and remove that instance from the report. 
 

• Option 3: Change the Section Reference in the paragraph to reference an applicable Section that is 
already contained in the Job. 

 
Solution: This will resolve the discrepancy and remove it from the report. 

 
 For additional guidance, watch the Section Verification Report eLearning module within Chapter 

6 – Correcting QA Report Errors and Discrepancies. 
 

  

https://www.wbdg.org/dod/specsintact/elearning
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SpecsIntact Automated Editing Functions 
 

Unlike standard word processing programs, the SI Editor features automated tools and wizards that 
ensure the accurate insertion of References, Submittals, and Section References. These tools 
automatically insert the required elements and apply the correct tags, saving you the time and effort 
of manual formatting. 
 
 
SI Editor’s Reference Tool and Wizard 
 

Within the SI Editor there are two very helpful functions available to assist you in both checking that 
you have the most up to date References as well as assisting with accurately inserting new or updated 
ones. 
 

 Both these Reference tools, by default, utilize the Unified Master Reference List (UMRL) 
from the UFGS Master you have connected. They scan it to find and compare Reference 
Organizations (ORGs), Reference Identifiers (RIDs), and Reference Titles (RTLs) within your 
Section to those in the UMRL. 

 

 Considering the above information, it is very important to always update your system to 
the latest released version of the Unified Master Reference List (UMRL). 
 

Manage your References with precision using these dynamic SI Editor tools: 
 

• Check Reference: Boosts productivity by making it easy to update existing References and 
alerting you to any that are missing and then offering to insert them for you providing they are 
found in the Unified Master Reference List (UMRL). 

 
• Reference Wizard: Extends the capabilities of the Check Reference tool by automating the 

insertion of new References with the correct formatting and tags. 
 

 To learn more about the SI Editor’s Reference Tool and Wizard, refer to the Check Reference 
and Reference Wizard topics in the Web-Based Help. 

 
 
Check Reference Tool 
 

The Check Reference tool is a quick and easy way to compare the References within your Section to 
those in the UMRL. Use the Check Reference tool to check whether an existing or added Reference 

CHAPTER 6: TOOLS, WIZARDS, 
AND TIPS 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_ToolMenu_CheckReference.htm&rhsearch=check%20reference&rhhlterm=check%20checking%20reference%20references
https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_ReferenceWizard_Overview.htm&rhsearch=reference%20wizard&rhhlterm=reference%20references%20wizard
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Identifier (RID) is up to date in the Reference Article. In the text, use this tool to check if it is also 
included in the Reference Article as required. 
 
To activate the Check Reference tool, whether it be in the Reference Article or anywhere in the 
Section text, simply place your cursor anywhere inside a pair of Reference ID (RID) tags, (e.g., 
<RID>ASTM|E1971</RID>) right-click and select the Check Reference menu option. If it is the latest 
Reference (according to the matching Reference in the UMRL) the following message pops up:  
  

  
  

If it is not a match to the latest Reference in the UMRL, then a window pops containing the difference 
in the Reference Titles between the RID in the current Section and the information in the UMRL. See 
example below: 
 

  
 
The UMRL Reference details are listed first, then the Reference in the Section, giving you a view of the 
difference between the two. By default, the Update Reference Title box is checked. To update the 
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Reference information to match the information in the UMRL, click Yes and it will be updated. To 
leave it as is, click No. 
 
 
Identify and Add Missing References with Check Reference Tool 
 

If you use the Check Reference tool to check a Reference in the text, and that Reference is missing 
from the Reference Article, you will be notified it is missing, and prompted to add it:  
  

  
 
If you click Yes, it will add the complete <RID>REFERENCE ID<RID> and <RTL>Date and Title</RTL> 
under the applicable Reference Organization and confirm it. Once you click OK, you can see where it 
inserted the Reference.  
 

  
 

    

 
 

 The Check Reference tool will not, however, tell you if a Reference ID (RID) that is listed in 
the Reference Article does not have a corresponding RID in the text anywhere. This 
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information will show up on the Reference Verification Report which is explained in that 
topic within this guide. 
 

 Hovering over a Reference within the RID tags, whether in the Reference Article or in the text, 
provides you with a mouse-over hint indicating if the Reference is found in the UMRL. If not 
found, it lets you know that as well. See examples below: 

 

 
 

 
 

 For additional guidance, watch the Using the Check Reference Feature eLearning module within 
Chapter 3 – Editing. 

 
 
Reference Wizard 
 

Adding a new Reference is made easy with the SI Editor’s Reference Wizard. 
 
 
Insert a New Reference in the Reference Article 
 

To activate the Reference Wizard to insert a new Reference in the Reference Article, place your cursor 
where you want to insert the new Reference Identifier (RID) and follow these steps: 
 

1. If the organization is already there, but you need to add an additional Reference Identifier 
(RID), you’d place your cursor within that organization above or below an existing RID based on 
the correct alphabetical order as shown below: 

 

 

https://www.wbdg.org/dod/specsintact/elearning
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2. Next, click the RID button on the SI Editor’s Tagsbar  or go to the Insert menu, 
select Tags, and find the RID tag and click OK to activate the Reference Wizard: 

 

 Note that since your cursor was within the DOD Reference Organization when you 
clicked the RID button, the Reference Wizard jumped directly to the list of DOD 
Reference Identifiers (RIDs) that are already listed in the Unified Master Reference List 
(UMRL). The UMRL list is based on what is contained in the UFGS Master you have 
connected to SpecsIntact. 
 

3. If the DOD Reference you need to add is already listed, select that one and click the OK button 
and it is inserted into to the Reference Article as shown below: 
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4. If, however, the RID you need is not listed, you would need to place a check in the Use empty 

tags option, then click OK to be able to add a new blank one: 
 

 
 

 In this instance, the Reference Wizard would insert a Reference Identifier (RID) template, 
which includes both the necessary RID tags and the Reference Title (RTL) tags. This makes it 
simple to then manually type in the appropriate RID and RTL information within the 
applicable tags: 

 

 
 
 
Insert a New Reference Anywhere in the Section Text 
 

To activate the Reference Wizard to insert a new Reference in the Section text, follow these steps: 
 

1. Place your cursor where you want to insert a new Reference Identifier (RID). 

2. Next, click the RID button on the SI Editor’s Tagsbar  or go to the Insert menu, 
select Tags, and find the RID tag and click OK to activate the Reference Wizard: 
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3. Scroll to find the Reference Organization you need (e.g., AASHTO). 
4. Double-click on the organization to load all the Reference Identifiers (RIDs) contained in the 

UMRL that are available to choose from. 
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5. Select the Reference ID and Title you need (e.g., AASHTO M 82). 
6. Click OK. You are then notified that this Reference is not in this Section’s Reference Article and 

are asked if you would like to add it: 
 

 
 

7. Click Yes, and the selected Reference get automatically added to your Section’s Reference 
Article with all the required tags, but also advises you to check these changes: 
 

 
 

8. Click OK, and the SI Editor jumps to the exact location the new Reference was added: 
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Inserting a Reference Organization Not Already Included in Section 
 

If the Reference Article doesn’t already contain the Reference Organization (ORG) you need to insert, 
follow these steps: 
 

1. Place your cursor in between the applicable existing Reference Organization’s beginning and 
ending REF tags as shown below: 

 

 
 

2. This time, to insert a whole new Reference Organization (REF) and Reference Identifier (RID), 

click the REF button  on the SI Editor’s Tagsbar, or go to the Insert menu, 
select Tags, and find the REF tag and click OK to activate the Reference Wizard. 

  

  
 

3. Next, scroll to find the Reference Organization you are looking for. Once found, double-click on 
it (AASTHO was used for this example), and all its associated Reference Identifiers (RIDs) are 
displayed. If the one you are looking for is listed, select it, then click OK and it is inserted with 
all the required information and tags: 
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 Note that if the Reference RID you wish to add does not show up in the organization’s list, you 
can always place a check in the Use empty tags option and click OK to insert the template 
information to allow you to manually type in the Reference Identifier (RID) and the Reference 
Title (RTL) information. 
 

 
 

 Please note this additional important information. If the Reference RID you select and insert 
in the Reference Article does not exist elsewhere in the Section text, you get the following 
pop-up message as a reminder: 

 

 
 

 We recommend inserting the RID into the appropriate text location immediately. However, if 
left unaddressed, SpecsIntact will flag the missing reference in the Reference Verification 
Report which is explained in that topic in this guide. 

 
 For additional guidance, watch the Reference Verification Report eLearning module within 

Chapter 6 – Correcting QA Report Errors and Discrepancies. 
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SI Editor’s Submittal Tool and Wizard 
 

Within the SI Editor there are two very helpful functions available to assist you in both checking that 
you have the most up to date Submittals as well as assisting with accurately inserting new or updated 
ones. 
 

 Both these Submittal tools utilize the UFGS Master 01 33 00 Submittal Procedures Section to 
scan and compare Submittal Descriptions for accuracy throughout Job Sections as well as 
Submittal Items within each Section to verify they are cited in both the Submittal Article and 
the text. 

 
Manage your Submittals with precision using these dynamic SI Editor tools: 
 

• Check Submittal: Boosts productivity by making it easy to update existing Submittals, alerting 
you to any that are missing, and then offering to insert them for you. 

 
• Submittal Wizard: Extends the capabilities of the Check Submittal tool by automating the 

insertion of new References with the correct formatting and tags. 
 

 To learn more about the SI Editor’s Submittal Tool and Wizard, refer to the Check Submittal  
and Submittal Wizard topics in the Web-Based Help. 

 
 
Check Submittal Tool 
 

The Check Submittal tool is helpful to easily check if a Submittal Item that is noted in the text of a 
Section is also listed in the Submittal Article – and vice/versa - as required.  
 
To activate the Check Submittal tool, whether it be in the Submittal Article or anywhere in the Section 
text, simply place your cursor anywhere inside a pair of Submittal (SUB) tags and right-click to check 
the current Submittal Item is cited in both places. 
 

    
 
  

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_ToolsMenu_CheckSubmittal.htm&rhsearch=check%20submittal&rhhlterm=check%20checking%20submittal%20submittals
https://www.wbdg.org/tools/specsintact/Help/index.htm#t=SIEditor%2FEditor_SubmittalWizardOverview.htm&rhsearch=submittal%20wizard&rhhlterm=submittal%20submittals%20wizard%20wizards
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Verifying a Submittal Cited in the Submittal Article 
 

To confirm a Submittal Item exists in both the Submittal Article and elsewhere in the Section text, 
follow these steps: 

1. Place your cursor inside the Submittal Item’s SUB tags (e.g., <SUB>Qualifications</SUB>). 

2. Right-click and select Check Submittal. 

3. The Check Submittal tool will then scan the Section to ensure the item is also cited outside the 
Submittal Article. 

If a matching Submittal Item is found elsewhere in the Section text, a window pops up confirming 
what Subpart it is located in. 
  

  
  

If a matching Submittal Item is not found, a different message window pops up, advising you that it 
should appear in an appropriate location outside the Submittal Article. This serves to alert you to then 
add it in the applicable place in the Section text. 
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  Additional information on Submittal placement locations can be found under the Section 
Submittal Discrepancies topic in this guide. 

 
 
Verifying a Submittal Cited in Section Text 
 
To confirm a Submittal Item exists in both the Section text as well as the Submittal Article, follow 
these steps: 

1. Place your cursor inside the Submittal Item’s SUB tags (e.g., <SUB>Qualifications</SUB>). 

2. Right-click and select Check Submittal. 

3. The Check Submittal tool will then scan the Submittal Article to ensure the item is also cited 
there. 

If a matching Submittal Item is also found in the Submittal Article, a window pops up confirming this 
as well as offering which Submittal Description (SD-01 through SD-11) it is located under, as in the 
example below: 
 

 
 
If a matching Submittal Item is not found in the Submittal Article, a window pops up confirming this 
and offers to add it. 
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1. Click No, and nothing happens. 
2. Click Yes, and the Submittal Wizard is automatically launched to assist you in placing it in the 

Submittal Article under the appropriate ‘SD-XX Submittal Description’. 
 

 Additional information on inserting new Submittal Items in the Submittal Article can be found 
under the next Submittal Wizard topic in this guide. 

 
 For additional guidance, watch the Submittal Wizard eLearning module within Chapter 3 – 

Editing. 
 
 
Submittal Wizard 
 

Adding a new Submittal is made easy with the SI Editor’s Submittal Wizard. 
 
 
Insert a Missing or New Submittal in the Submittal Article 
 

The Submittal Wizard mentioned in the previous topic is used to insert a missing Submittal Item in the 
Submittal Article. Depending on whether the Submittal Item already exists in the text of the Section or 
you are inserting a new one, follow these steps to insert it in the Submittal Article: 
 

• Submittal Item already exists in Section Text: Activate this wizard by right-clicking inside the 
SUB tags of the existing Submittal Item (e.g., <SUB>Qualifications</SUB>) then right-click and 
select the Check Submittal menu option. 
 

• Type in New Submittal Item: To insert a completely new Submittal Item, first type the text, 

then highlight it. Next, click the Submittal  button located on the SI Editor’s Tagsbar. 
 
Either of the above options will activate the Submittal Wizard when a matching Submittal Item is not 
found in the Submittal Article. First, you are alerted that a matching Submittal Item is not found in the 
Submittal Article and are prompted if you would like to add it. If you click Yes, the Submittal Wizard is 
launched to assist you in placing it under the appropriate ‘SD-XX Submittal Description’ in the 
Submittal Article. 
 

1. Select the appropriate Submittal Item, Submittal Description, Approval/Classification and 
Reviewer options from the Submittal Wizard window. For demonstration purposes, we’re 
going to insert a new ‘Qualifications’ Submittal Item under the ‘SD-07 Certificates’ Submittal 
Description and give it a ‘G’ classification code. Since this is already an available option in the 
Submittal Wizard window, we can select it with those options as shown below: 

https://www.wbdg.org/dod/specsintact/elearning
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2. Once you have made the appropriate selections, click OK and the Submittal Item is added to 
the Submittal Article under the applicable Submittal Description (SD-01 through SD-11) and a 
confirmation window appears suggesting you review the changes to be sure they are correct: 

 

 
 

3. Click OK and the SI Editor jumps to the location of the newly added Submittal Item for you to 
easily review: 
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Submittal Wizard Options 
 

When adding a Submittal Item from the Submittal Wizard window, you have many options to choose 
from. If you do not find the exact Submittal Item needed already listed under the applicable Submittal 
Description (SD Number), you can manually make choices from all the available sections in the 
Submittal Wizard window. 
 
• Show submittals from this submittal list: In the middle of the Submittal Wizard window, there is 

an option to choose what Submittal Item list to load. The default is the Unified Master Submittal 
List (UMSL) which is included as part of the UFGS Master you have connected. Additionally, you 
can select just those that are in the current Section or choose a connected Master. To select an 
option other than the default UMSL, click the drop-down arrow in the Show submittals from this 
submittal list option. 

 

 
 

• Approval: In the Approval section of the Submittal Wizard window, you have an option to select 
an appropriate Classification code from drop-down list and manually insert a Reviewer code: 

 

 

 
 

 If you hover over the Classification and Reviewer options in the Approval section, you get pop-
up hints with some guidance as to which classification codes should be selected: 



 
 

128     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

 

 

 

 
• Submittal Description (SD Number): Select the applicable SD Number you want to insert your 

Submittal Item under in the Submittal Article. 
 

 
 

 If you select or hover over a particular Submittal Description (SD Number) in that section of 
the Submittal Wizard window, you get pop-up hints about that SD Number. See example 
above. 

 
Once all your Submittal selections have been made, click OK to insert your Submittal in the Submittal 
Article with all your selected options applied. 
 

 If you add a Submittal anywhere in the text of the Section (outside the Submittal Article), it 
MUST also be added in the Submittal Article under a valid Submittal Description. 
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 Additional information on Submittal discrepancies can be found under the Submittal 
Verification Report in this guide. 

 
 For additional guidance, watch the Submittal Wizard eLearning module within Chapter 3 – 

Editing. 
 
 
SI Editor’s Section Reference Tool and Wizard 
 

The SI Editor provides both a Section Reference tool and a Section Reference Wizard to ensure your 
project remains complete and accurate. These tools allow you to open referenced Sections directly 
from your current Section, making it easy to review their applicability. Furthermore, the Section 
Reference Wizard automates the process by inserting the reference into your text while 
simultaneously offering to add the referenced Section to your project. 
 
 
Check and Open Referenced Section from Within Current Section 
 

A Section Reference is used to reference other Sections and used for quality assurance and quality 
control of critical project elements. 
 
To quickly and easily open a referenced Section from within the currently opened Section, right-click 
on that Section Reference (e.g. <SRF>01 33 00</SRF>) and select the Open Section Reference option. 
This Section then automatically opens in a new window in the SI Editor. 
 

 When a referenced Section is opened, your original Section stays open underneath. To go back, 
just close the newly opened Section by clicking the small 'x' at the top right of the SI Editor 
window. 

 
 
Section Reference Wizard 
 

The Section Reference Wizard automates the insertion of Sections and Section References within 
other Sections. By default, when activating the Section Reference Wizard within a Section in your Job, 
it only loads the Sections already contained in your project to choose from. The selected Section 
Reference is added complete with all the necessary components; the Section number itself gets 
inserted within Section Reference <SRF> tags, and the Section title is also inserted. This eliminates the 
need to manually type it, along with the necessary tags and components, and avoids keying errors 
causing potential discrepancies on the Section Verification Report. 
 

https://www.wbdg.org/dod/specsintact/elearning
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1. To activate the Section Reference Wizard to insert a Section Reference, simply place your 
cursor where you would like to insert the new reference to another Section, then click the 

Section Reference  button on the SI Editor’s Tagsbar. The Section Reference Wizard 
window opens: 
 

  
 

 By default, when activating the Section Reference Wizard, it loads the Sections already 
contained in your project to choose from. 

 

 If you choose to reference a UFGS Master Section that is not already included your Job, you 
can select the Master: UFGS (primary Master) option from the Show Sections from: drop-
down box, and search for the Section you want to reference from the whole UFGS database, 
not just the ones already in your Job. 
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a. Once you find the needed Section, click OK. This will add the Section Number, along with the 
applicable Section Reference <SRF> tags and the Section Title in the text of the current 
paragraph exactly where your cursor was when you clicked the SRF button (e.g., <SRF>06 61 
16</SRF> SOLID SURFACING FABRICATIONS). 

 
b. Next, you are prompted to follow through and add the selected Section to your Job. Be aware 

that if you do NOT add the Section to your Job it will show up on the Section Verification 
Report as a missing Section. 

 

 
 

c. To proceed with adding the Section to your Job click Yes, and the Section is added to the Job. 
When you exit the SI Editor, you will see the newly added Section listed under your Job in the 
SI Explorer. 
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 If you are going to cite another Section within a Section in your Job, then you MUST also ADD 
it to your Job. 

 

 Additional information on Section References can be found under the Tags and Section 
References and Section Verification Report topics in this guide. 

 
 For additional guidance, watch the Section Verification Report eLearning module within 

Chapter 6 – Correcting QA Report Errors and Discrepancies. 
 
 

Additional Noteworthy SpecsIntact Menus 
 
Beyond the wizards and tools covered in earlier chapters, SpecsIntact offers several options for 
customizing and tracking your projects. Both the SI Explorer and SI Editor contain comprehensive 
menu options designed to streamline navigation and provide immediate access to help resources, 
ensuring you can find the answers you need for any task. 
 
 
SI Explorer - Customizing Views 
 
Additional menu options in the SI Explorer allow you to customize the content you are viewing and 
utilizing in your Jobs and Masters. 
 
• Column Headers: Go to the View menu and select Column to add/remove or change the order of 

the Section Columns that are displayed. See example below: 
 

 
 
• Choose Options to activate when SpecsIntact starts: Go to the Setup menu and select Options. 

From the General tab, select options to use when the SI Explorer is open (e.g., Save user name in 
Section properties when saving Sections or allowing SpecsIntact to automatically Check for 
Updates). Some suggested options are checked by default, but you can check/uncheck those you 
prefer. 
 

 Utilize the Specifiers tab under Options to manage specifier names. These names then 
become available in the Specifiers tab in the Properties for Job window, where you can 

https://www.wbdg.org/dod/specsintact/elearning
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assign these specifiers to the Divisions they are responsible for. Click the dropdown arrow 
next to the applicable Division to select from the pre-entered specifier list of names. 

 
• Change Colors on Folders and Sections: You can change the color of the Job, Master or Section file 

icons by right-clicking on them and choosing the applicable Icon Color option from the right-click 
menu. 

 
 
SI Explorer – Keyboard Shortcuts 
 
Here is a list of available keyboard shortcuts for use in the SI Explorer: 
 

• Ctrl + Key: 
o New Job - Ctrl+J 
o New Master - Ctrl+M 
o Print/Publish - Ctrl+P 
o Add Sections - Ctrl+A 
o Edit - Ctrl+E 
o Search and Replace - Ctrl+F 

• Function Keys: 
o Screen Refresh – F5 
o Options – F2 
o Help – F1 
o Delete – delete key 

 
 
SI Explorer - Menu Options 
 
The SI Explorer menus offer some additional features and functions not readily available as shortcut 
Icon buttons on the main button panel. 
 

 Not all the options on the listed SI Explorer menus or tabs below are mentioned - just the 
notable ones that have not already been addressed elsewhere in this guide. 

 
 
SI Explorer - File Menu 
 
When a specific Job under the Jobs folder is selected, most of the options on the File menu are 
available. The Job name becomes part of some of the options, which helps to alert you to what Job 
you are performing these functions on. As previously stated, you can also right-click on the Job name 
to bring up most of these menu options. 
 
Noteworthy options on the File menu: 
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• Delete Job: Select the Job you wish to delete and select this option. 
 

• Duplicate Job: Duplicate the Job under a new Job name. 
 
• Rename Job: Do not try to rename a Job folder outside of SpecsIntact. You must use the 

SpecsIntact software to rename a Job. 
 
• Backup and Restore: It is always good practice to back up your Jobs and any local Masters 

regularly. It’s also a good way to archive a finished Job. This same function also provides a method 
for emailing your entire Job or Master in the .ZIP file format. Once you’ve stepped through the 
backup process and created a backup ZIP file (e.g., MYJOB_J.ZIP), you can then attach the file to an 
email to easily share it with others who can then utilize the Restore tab from the Backup and 
Restore window to load the Job into their SpecsIntact software. 

 

 To quickly attach one or more Sections to an email, right-click on the highlighted Section(s) 
and select the Email option to automatically attach them to a new Outlook message. All that’s 
left for you to do is add the recipient and click send. 

 
 For additional guidance, watch the Backup a Job or Master and Restore a Job or Master  

eLearning modules within Chapter 8 – Additional Tools and Techniques. 
 

• Search and Replace: Search and/or replace a word or phrase within ALL Sections of the selected 
Job. 
 

• Export Search Results: This option generates a ‘SearchResults.htm’ file listing all the Search results 
for the selected Job and places it in the Exported Files folder of the Job. If that folder does not yet 
exist, SpecsIntact creates it. Job search term results contain a list of the Sections the search term 
was found in and number of times it was used in each Section. 

 

 This option is only available when search results have been generated and placed under the 
Exported Files folder that is generated under the applicable Job folder. 

 
• Execute Revisions: This option allows you to Execute Revisions on the entire Job. This will make 

additions and deletions permanent in ALL Sections by removing all <DEL> tags and deleted text 
inside them, as well as making any additions permanent and removing the <ADD> surrounding 
that text. 

 
• Remove Change/Highlight Tags: This option allows you to globally remove all Change (CHG) or 

Highlight (HLS) tags, but not their content, from the entire Job. 

https://www.wbdg.org/dod/specsintact/elearning
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• Remove English/Metric Units: This option allows you to globally remove all Metric or English tags, 

including their content, from the entire Job. 
 
• Save to XML Format: This capability is primarily intended for updating older Standard General 

Markup Language (SGML) SpecsIntact Jobs to the newer Extensible Markup Language (XML) 
format for an entire Job. 

 
• Specify PDF Folder: This option allows you to change the location of the Job PDF Files folder. 

 
• Specify Word Folder: This option allows you to change the location of the Job Word Files folder. 

 
• Properties: This option opens the Properties for Job window for the selected Job. 
 
 
SI Explorer - Sections Menu 
 
When a Section (or Sections) are selected under a specific Job, most of the options on the Sections 
menu are available. As previously stated, you can also right-click on a Section or group of selected 
Sections to bring up most of these same menu options. 
 
Noteworthy options on the Sections menu: 
 
• Copy: This option allows you to copy the selected Section from the current Job to another Job. If 

preferred, use the standard keyboard shortcut keys to copy and then paste the Section into the 
target Job. 

 You can also drag and drop Sections to copy Sections from one Job to another. 
 

• Submit UFGS CCR for: This option allows you to submit a Criteria Change Request (CCR) for the 
selected Section. This option will take you directly to the online form where you can fill out details 
for your suggested Section change request. 

• Change/Revision History for: This option allows you to open the National Institute of Building 
Sciences (NIBS) Whole Building Design Guide (WBDG) Website's UFGS Section page for the 
selected Section in your default browser. 
 

• Renumber: This option allows you to permanently renumber the Subpart levels within the 
selected Section(s) of the actual Section (.sec) files, not the processed (.prn) files. 
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• E-mail: To email files from any folder in the SI Explorer, right-click your selection and select E-mail. 
This automatically opens a new email window with your selected Sections or PDFs already 
attached and ready to send. NOTE: The default email address is the SpecsIntact Support email 
address; however, you can change it as needed. 

• Rename: This option allows you to rename the selected Section (change the Section Number) or 
name of a Document. 
 

 Do not open and edit a Section to change its number, you MUST change the number using 
this option. 

 
• Delete: This option allows you to delete the selected Section or multiple selected Sections. 
 
• Overwrite: This option allows you to overwrite one or more selected Sections in a Job. Right-click 

on the Section(s) and select Overwrite to replace the Section(s) from the original source. NOTE: 
The source of the Section must be a Master or Job that is still available on your system. 

 
• Delete Section Comments: This option allows you to delete the Section Comments for a Job in one 

or more selected Sections. 
 

• Properties: This option allows you to open the Section Properties window on the selected Section. 
 
The following options on the Sections menu were explained in the SI Explorer - File Menu above in this 
guide. However, when accessed from the Sections menu they can be applied to one or more selected 
Sections without having to be applied to all the Job Sections: 
 

• Tailor 
• Search and Replace 
• Execute Revisions 
• Remove Change/Highlight Tags 
• Remove English/Metric Units 
• Save to XML Format 

 
 
SI Explorer - Process Menu 
 
Noteworthy options on the Process menu: 
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• Reference Processing for Job: This is a multi-function window for processing References 
throughout a Job. Select options that allow you to process References (Reconcile references in 
Reference Articles, Generate new Reference Articles in Sections, etc.) on all .SEC Section files in 
your Job. You can also access options that allow you to generate, edit or print a Supplemental 
Address List or Supplemental Reference List – also based on the UMRL or UFGS database of your 
choice. 
 

• Release Processing for Job: This option allows you to generate or update a specific Job’s: 
 
o Project list of Sections (Pull Table) 
o Mark all as unified (or old) submittal format 
o Delete all Sections properties.  

 

 All other options in this window are grayed out, as they only pertain to Release Processing 
when a Master is selected instead of a Job. These include: 
 

o Table of contents with/without scope 
o Master Reference List 
o Reference Location List 
o Master Submittal List 
o Tailoring Option List 
o Set MasterFormat version 

 
• Convert Manual Lists to Order Automatically: This feature is used to convert lists that use the LST 

and ITM tags in an entire Job or Section to use the alpha-numeric Ordered Lists that will renumber 
and re-letter automatically. 
 

• Convert to Automatic Paragraph Numbering: The conversion process will remove the Subpart 
number and three spaces from all Subpart Titles throughout the Sections. Once this is done, a 
Meta Data (MTA) tag will be added at the top of each Section. After completion, SpecsIntact will 
automatically number the Subparts for the Sections while editing, printing, and publishing. 
 

• Convert Font Attribute and Center Tags to BLD, UND, ITA and CTR: This option will convert all the 
applicable HL1, HL2, HL3, and HL4 tags in your Job Sections to the updated/applicable Bold (BLD), 
Underline (UND), Italics (ITA) and Center (CTR) tags. 

 
• Export Submittal Register for Job: This feature is used to export the Submittal Register data to 

either a web file, spreadsheet, or comma-delimited file. 
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• Package Builder: This option offers many options for creating a comprehensive PDF package for a 
Job or Master. You can compile a single PDF file by adding PDF Section files and report files from 
SpecsIntact, as well as adding other external PDFs from outside of SpecsIntact, and arrange them 
in any order you choose. 

 
 
SI Explorer - View Menu 
 
Noteworthy options on the View menu: 
 
• Toolbar: Display or hide the SI Explorer’s Toolbar. 

 
• Status Bar: Display or hide the SI Explorer’s Status Bar. 

 
• Columns: Display or hide available Column names in the SI Explorer's Contents pane or change the 

order in which they appear. 
 

• Refresh: The Refresh feature reloads/updates to the information currently displayed. 
 
 
SI Explorer - Tools Menu 
 
Noteworthy options on the Tools menu: 
 
• Section Template: This template is used as an outline for creating new Sections. This option allows 

the user to manage their Section Templates by either creating a new template, editing, copying, or 
deleting an existing template. 

 

 New Sections can be created from the Add Sections window. Additional information on 
adding a new Section from an existing Section Template can be found under the Adding 
Sections to a Job topic in this guide. 

 
• SI Document Templates: This option allows access to blank SI Document Templates that can be 

used to create cover sheets, sign-off sheets, project information sheets, or other unique 
documents to be used with specifications in multiple Jobs. 

 
• Software Change Request: This menu gives you the options to create/edit, delete or print forms to 

submit SpecsIntact Software Change Requests. 
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• SI Editor: This option opens the SpecsIntact Editor so you can either create a new Section or 
document or open an existing file. 

 
• Find Files: This option opens the standard Microsoft Windows advanced Search Tools window so 

you can perform a broad search for files located on your computer and network drives. 
 
• Windows Explorer: This option provides an easy way for the user to jump to/open the selected 

Job or Master folder location in Windows Explorer. 
 
 
SI Explorer - Setup Menu 
 
Noteworthy options on the Setup menu: 
 

 Additional information on the first two Tools menu options (Working Directories and 
Connect Masters) can be found under the Working Directories and Connect Masters topic 
in this guide. 

 
• Install SpecsIntact PDF Printer: This function will install or reinstall the SpecsIntact PDF printer for 

both SpecsIntact and SpecsIntact Lite. 
 
• Options: Open this to set default behaviors and options for Jobs. The General tab has many 

settings to choose from as well as options on when you want SpecsIntact to check for updates to 
the software, UFGS Masters and/or UMRL. Click on the Specifiers or File Locations tabs to add 
that type of information for easy insertion or quick access within your Jobs. 

 
• Reset Settings: The options within this window will restore the settings back to the application 

defaults. 
 
 
SI Explorer Help Menu 
 
From the SI Explorer Help menu, you can access the following: 
 
• SpecsIntact Help: Links directly to the searchable SpecsIntact Help database. 
 
• Check UFGS Master Version: This option lets you check if you have the latest released copy of the 

Unified Facilities Guide Specifications (UFGS). 
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• SpecsIntact Website: Links directly to the SpecsIntact website resources to download software 
and Masters and keep up on new developments regarding the software. 

 
• SpecsIntact Web Help Center: Links directly to the SpecsIntact website for resources to assist both 

novice and proficient users. Here you can discover the Installation Guide, eLearning Modules, 
Online Help and Support Center. 

 
• Unified Facilities Guide Specifications (UFGS): Links directory to the UFGS Masters webpage. 

 
• UFGS Changes and Revisions: Links directory to the UFGS Master Changes and Revisions webpage. 

 
• Send Log File to Help Desk: This option automatically generates an email, addressed to the 

SpecsIntact Help Desk, with the SpecsIntact Explorer error log (Errorlog.log) attached. This log 
records many of the issues encountered and is sometimes necessary for our Technical Support 
Team to help troubleshooting and fix problems. 

 
• About SpecsIntact: Allows you to Check SI Version, Check UFGS Version, or Show Disclaimer 

options. This window also displays the current SI version (e.g., SI v5.7.0.230) and what kind of SI 
installation was used (e.g., SI executable installation). 

 

 Both the SpecsIntact version and installation type are important when contacting tech 
support for assistance. 

 
 
SI Editor - Editing Tips 
 
The SI Editor has some very helpful editing tools including, keyboard shortcuts and many ways to 
select text for editing and deleting. 
 
 
SI Editor – Keyboard Shortcuts 
 
Here is a list of available keyboard shortcuts for use in the SI Editor: 

https://www.wbdg.org/tools/specsintact/InstallationGuide.pdf
https://www.wbdg.org/dod/specsintact/elearning
https://www.wbdg.org/dod/specsintact/support-help-center
https://www.wbdg.org/dod/specsintact/masters
https://www.wbdg.org/dod/ufgs/ufgs-changes-revisions
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• Ctrl + Key: 
o Delete - Ctrl+D 
o Copy - Ctrl+C 
o Copy Without Tags - Ctrl+E 
o Find - Ctrl+F 
o Replace - Ctrl+H 
o Find Tags - Ctrl+I 
o Remove Tags - Ctrl+M 
o Toggle Indentation - Ctrl+N 
o Open - Ctrl+O 
o Print Draft - Ctrl+P 
o Save - Ctrl+S 
o Paste - Ctrl+V 
o Cut - Ctrl+X 
o Redo - Ctrl+Y 
o Undo – Ctrl+Z 
o Page Break – Ctrl+Enter 

• Function Keys: 
o Repeat Last Set of tags – F2 
o Next – F3 
o Help - F1 
o Insert Tags - F4 
o Spell Check - F7 

 
------------------------------------------ 

 
• Shift + Function Keys: 
o Revisions On/Off - Shift+F8 

 
------------------------------------------ 

 
Delete tagged elements -  
Shift+Delete 

To toggle the following screen 
elements on or off: 
 
• Alt + Key 
o Tags - Alt+S 
o Notes - Alt+N 
o Revisions - Alt+R 
o English Units - Alt+G 
o Metric Units - Alt+M 
o Both English/Metric - Alt+B 
o Marks - Alt+A 

 
 
SI Editor – Editing Techniques 
 
There are various techniques available in the SI Editor that can be used to select tagged elements and 
text. Combining these techniques will help you become a proficient editor. 
 
 
Methods for Selecting and Deleting Text 
 

Use keyboard shortcuts, double-clicking, selecting and scrolling, as well as other methods of 
highlighting text in the SI Editor. 
 
Keystrokes for Selecting Text 
 

• Shift+Right or Left arrow - selects one character at a time. 
• Shift+Ctrl+Right or Left arrow - selects one word at a time. 
• Shift+End - selects from cursor to end of a line. 
• Shift+Home - selects from cursor to beginning of a line. 
• Shift+Down or Up arrow - selects one line at a time in the applicable direction. 
• Shift+PgDn or PgUp - selects a page at a time in the applicable direction. 
• Shift+Ctrl+Home - selects from cursor to the beginning of the Section. 
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• Shift+Ctrl+End - selects from cursor to the end of the Section. 
 

 You can delete tagged text using the Shift+Delete keys. 
 

 Additional information on selecting and deleting text can be found under the Deleting Text 
topic in this guide.  

 
Double-click Method to Select Text 
 

When removing a subpart, double-clicking is the recommended method for selection. Unlike manual 
highlighting, double-clicking automatically includes all hidden tags and elements. This keeps your 
document clean and prevents tagging errors and stray spaces or unnecessary hard returns. 
 
To remove an entire subpart, follow these steps: 
 

1. Place the cursor on a word within the subpart title and double-click. 
2. Double-click again and the selection expands to include the immediate surrounding text and 

pair of tags. 
3. Double-click one more time and the selected region expands to include entire subpart. 

 
If needed, you can continue to use this method until you have multiple subparts selected or even the 
entire Part.  
 

 Be aware that you cannot select an entire Section by using the double-click method. 

 

 Once you become comfortable with the double-clicking method, you may want to try out 
the Shift+Delete keyboard shortcut for removing entire subparts. 

 
Highlighting Text and Deleting Using Revisions 
 

While using Revisions the most efficient way to remove key elements such as TXT, LST, and ITM tags is 
by using the mouse to highlight these areas. By learning to do this correctly you will avoid leaving 
unnecessary space(s) between words and throughout the Sections. 
 

 The best way to remove only the tags, not the text, without having to turn Revisions OFF is 
to use the keyboard shortcut Ctrl+M or place the cursor between the tags (e.g., 
<SUB>|</SUB>), right-click and choose the Remove Tags option. 

 
The following example shows where to begin and end the highlighted text you wish to delete: 
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 In instances where you use the highlighting and scrolling method to select text it is very 
important to do it properly. This means including blank lines and extra spaces as shown 
above. 

 
This is the result of highlighting and deleting as shown above with Revisions ON: 
 

 
 
These examples can also be used whether you are using Revisions or not, but it is the preferred 
method for editing with Revisions ON. 
 
 
SI Editor Menu Options 
 

The SI Editor menus offer some additional features and functions not readily available as shortcut Icon 
button options on the Tagsbar. Not all the options on the listed menus or tabs below are mentioned -
just the most notable ones. 
 
 
SI Editor - View Menu 

 
• Toolbars and Docking Windows: Default options are already checked and active on each of the 

tabbed option windows. Uncheck options you do not wish to be default settings on each of the 
following tabbed windows. A few notable options are noted under each tabbed option below: 
 
o Save tab: Make choices in the available drop-down option fields. 

 
(1) Perform automatic backups every: Select how often you want the SI Editor automatically 

backs up Section edits (1 to 100 minutes). 
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(2) Tailoring options deletion drop-down options: At the bottom of the Save tab, the default 
option is Prompt before deleting hidden Tailoring Options. Click the drop-down option to 
change it to one of the other 2 options available. 

 
o Edit tab: See sample of available checkbox options on this tab. 

 
(1) Provide hint text when the mouse cursor hovers over tags 
(2) Retain last Revisions view setting when closing a Section file 
(3) Use Submittal and Section Reference Wizards 
 

o References tab: From this tab, you can choose whether to use the Reference Wizard for 
inserting Reference tags, which Reference List to use for checking references, and whether to 
check for UMRL and USML updates automatically. 
 

o Display and Navigator tab: Choose which SI Editor theme to use, whether to display the SI 
Navigator on the left-hand side of the SI Editor, and even increase or decrease the size of the 
Icons on the SI Editor’s Tagsbar. 
 

• Editor Theme: Choose from Classic, Twilight, Deep Blue, Midnight, or Custom. 
 

• Application Look: Choose from Blue, Light Blue, Silver, Gray, Back, Classis Blue-Gray or Retro 
Gray. 

 
• Tailoring Options: Opens the Tailoring Options window to view all Tailoring Options available in 

the current Section. 
 

• View options not available as buttons on the default Tagsbar: English, Metric (or Both), Marks, 
Colors, Numeric Paragraphs. NOTE: All these options also have keyboard shortcuts available to 
turn them on/off. 

 
 
SI Editor - Insert Menu 
 
• Page Break (Ctrl+Enter): Inserts a hard page break where needed. 

 
• Insert Tags (F4): Access and insert all tags from here, in addition to the ones available on the SI 

Editor’s Tagsbar. 
 

• Last Tag (F2): Quickly repeat inserting the last tag you previously inserted. 
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• Tailoring: Select and insert Tailoring Options tags around selected text or remove existing Tailoring 

Options. 
 
 
SI Editor - Format Menu 
 
• Change Case (Alt+K): Opens the Change Case window to allow you to quickly change the case on 

the selected text. 
 

• Increase Ordered List Indentation (Tab): Click the Tab key inside an ordered list item (OLI tags) to 
increase the level of indentation. 

 
• Decrease Ordered List Indentation (Shift+Tab): Click the Shift+Tab keys inside an ordered list item 

(OLI tags) to decrease the level of indentation. 
 
• Promote Subpart: This option only works to increase the level of the selected subpart, by right-

clicking on the subpart in the Navigator. 
 
 
SI Editor - Tools Menu 
 
• Options: This brings up the same window as the Toolbars and Docking Windows menu under the 

SI Editor - View Menu above. 
 
• Thesaurus Lookup (F8): Select a word to get a list of Similar Terms, Synonym and Antonym 

category options.  NOTE: You must have a word highlighted before selecting this option. 
 
 
SI Editor - Help Menu 
 
• Submit a CCR for Section: This option loads the Change Criteria Request (CCR) form to allow you 

to report and submit a technical or non-technical (grammatical) change to the current Section. 
 

• About SpecsIntact Editor: Displays the version of the SI Editor you have installed (e.g., SI 
v5.7.0.230). 
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Additional SpecsIntact Editing Info and Tips 
 

There is some additional helpful information within this topic that will aid you during the editing 
process. 
 

 
Tag Character Limits 
 

Certain component tags within SpecsIntact Sections have character limitations you should be aware 
of: 
 

• Section Title (within STL tags): 
o 120 Characters (e.g. <STL>PROJECT SCHEDULE</STL>) 
 

• Section Number (within SCN tags): 
o 14 Characters (industry standard - e.g., <SCN>01 32 01.00 10</SCN>) 

 
• Date (within DTE tags): 

o 5 Characters (e.g., <DTE>08/23, CHG 1: 08/24</DTE>) 
 

• Article Titles (within TTL tags in a two-level subpart): 
o 71 Characters (e.g., <SPT =1.1>1.1   <TTL>REFERENCES</TTL>) 

 
• Paragraph Titles (within TTL tags in a three-level subpart): 

o 68 Characters (e.g., <SPT =2.1.1>2.1.1   <TTL>Contractor Software</TTL>) 
 

• Sub-Paragraph Titles (within TTL tags in a four-level+ subpart): 
o 60 Characters (e.g., <SPT =2.1.2.2>2.1.2.2   <TTL>Contractor Software</TTL>) 

 
• Reference Organization (within ORG tags): 

o 511 Characters (e.g., <ORG>U.S. ARMY CORPS OF ENGINEERS (USACE)</ORG>) 
 

• Reference Identifier (within RID tags): 
o 30 Characters (e.g., <RID>ER 1-1-11</RID>) 

 
• Reference Title: (within TTL tags): 

o 300 Characters (e.g., <RTL>(2017) Administration - Project Schedules</RTL>) 
 

• Section Reference: (within SRF tags): 
o 14 Characters (industry standard - e.g., <SRF>01 33 00</SRF>) 
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Table Formatting and Editing Tips 
 
Here are some helpful tips when creating and editing a Formatted Table: 
 
• Use TXT, LST, ITM or CTR Tags Outside of Table: For additional flexibility, tables may be placed 

within Text (TXT), List (LST), Item (ITM) or Center (CTR) tags to allow more control of table 
positioning within the page margins. 

 
• Use UND, ITA and BLD Tags Inside Table Cells: Formatting tags that you can use around text inside 

a table are those for underline (UND), italics (ITA) and bold (BLD). 
 
• Use Table Menu to Adjust/Justify Text inside Table Cells: Use the Table menu > Justify option 

inside a cell to select to adjust text within it to the Left, Center, or Right. This will make table 
editing less complicated than using tags. 

 
• Tagging References and Submittal Within a Table: Apply additional tagging for References and 

Submittals, etc. after all the information has been entered into the table. 
 

• Tables inside Notes: A table can be located inside a Note. However, do NOT place note paragraph 
(NPR) tags around a table within a Note. 

 
• Formatting English/Metric Within a Table: When using measurements in a table, the preferred 

method is to duplicate the formatting and make a separate table for each measurement (English 
and Metric). Check for formatting by turning off the tags for each type of measurement separately 
to ensure clean formatting for both. 

 
• Using Revisions Within a Table: When using Revisions to markup a table consider duplicating the 

table first, edit the added table then completely delete the existing table so it will be surrounded 
by the DEL tags. 
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SI Editor - Validation Errors 
 

Upon saving a Section in the SI Editor, the Section is automatically scanned for any tagging errors. If 
any are found, a Validation Error log is generated, and a message alerts you: 
 

 
 
To see the Validation Error log, click Yes and it opens it in a new SI Editor window: 
 

 
 

 Just as in other SpecsIntact reports, you can double-click on the subpart number to jump 
to the subpart location of the error in the Section. 

 
 
Understanding and Fixing Validation Errors 
 

In the example above, the validation error is informing you that subpart 1.1 is missing a title, or if it 
does have a title, it does not have TTL tags surrounding it. In this case the latter is true, as shown 
below: 
 

 
 



 
 

149     User Guide                                                                                  02.27.2026 
 

 
SpecsIntact User Guide 

 Validation errors are based on SpecsIntact tagging rules, so in this example, the SI Editor is 
expecting to find TTL tags within every subpart in the Section. If any subpart does not have 
TTL tags it is then reported when the Section validation scan is done. 
  

 Additional information on SpecsIntact tagging rules can be found under the Tag Rules topic in 
this guide.  

 
 
Additional Validation Error Examples 
 
Here are some additional examples of other validation errors and how to fix them: 
 
• Rules Violation: Subpart has no title (TTL tags missing) 

 
o In the previous example, this validation error was simply a matter of missing TTL tags around 

the REFERENCES title. 
 

o This same validation error occurs when a whole subpart is deleted, but the subpart tags 
themselves are inadvertently left in and not deleted. In this case the validation still was just 
searching to make sure every set of subpart tags include a <TTL>Title</TTL>, and none was 
found in either of these scenarios, resulting in the same exact validation error. 

 
• Rules Violation: Reference has no Organization (ORG tags missing) 
 

o In this case, validation found a set of REF tags in the Reference Article that is missing an 
organization name (e.g., ‘ASTM INTERNATIONAL (ASTM)’) or it was there but the required ORG 
tags were missing around it. 

 
• Rules Violation: Reference “ASTM INTERNATIONAL (ASTM)” Unequal numbers of Reference 

Identifiers (3) and Reference Titles (2) 
 

o In this case, validation compared the number of Reference Identifiers (RIDs) within the ASTM 
INTERNATIONAL (ASTM) Reference Organization, and it found (3) RIDs but only (2) had the 
required Reference Title (RTL) tags associated with them. So, either one of the RIDs was 
missing or the Reference Title was there but it did not have the required RTL tags around it. 
The latter was the case in the example below (e.g., RTL tags are missing from around the 
Reference Title for ASTM E1971): 
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• Rules Violation: ‘SPT’ Cannot Contain ‘SUB’ 
 

o In this case, validation scanned the Submittal Article to make sure all the necessary 
information and tags were correct around all the Submittal Descriptions and Submittal Items. 
According to the Validation Error log, it found a Submittal Item surrounded by SUB tags by 
itself. This is a violation of a tagging rule, as SUB tags cannot be inserted in the Submittal 
Article paragraph without being surrounded with a formatting tag (TXT, LST, or ITM). See 
example below: 

 

 
 

So, in this case, the correct tag to insert around this Submittal Item is the ITM tag since that 
contains the needed indentation level as shown in the ‘Training Plan’ Submittal Item below it. 

 

 There are additional scenarios that occur that can cause validation errors like the ones outlined 
above. This is why it is important to be familiar with SpecsIntact tagging rules so when these 
occur, you’ll be equipped to identify and correct the error. Additional information on 
SpecsIntact tagging rules can be found under the Tag Rules topic in this guide. 

 
 For additional guidance, watch the eLearning modules within Chapter 5 – Resolving Validation 

Log Errors. 
 
 
SI Editor - Tagsbar Layout Hints 
 
If you look closely at the Tagsbar in the SI Editor, the tag buttons are laid out in the order they are 
used throughout a Section. Additionally, if a color is associated with a particular element, the tag 

https://www.wbdg.org/dod/specsintact/elearning
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button is also color-coded appropriately to that element (e.g., the Submittal (SUB) button is bright 
blue). 
 

 
 
Section structure tags are the first tags listed on the Tagsbar. These are listed in the order in which 
they are used: 

 
 

• Part (PRT): Outermost tag for each of three required Parts 
 

• Parts contain Subparts (SPT) 
 

o Subparts MUST contain Titles (TTL) 
o No text inside a Subpart can be untagged, so it MUST be surrounded by one of the 

available formatting tags (TXT, LST, or ITM) 
 

• TXT, LST, and ITM tags can contain additional tagged elements within the text inside them: 
 

       
 

o Metric (MET) or English (ENG) measurements 
o Reference Identifiers (RID) 
o Submittal Items (SUB)  
o Section References (SRF) 
o Bold (BLD) 
o Italic (ITA) 
o Underline (UND) 

 

 Additional information on Section tags can be found under the SpecsIntact Tagging topic in 
this guide.  

 
 
Submittal Register 
 
The Submittal Register lists the materials, products or items for each Submittal cited in the Job, as 
well as the Section and paragraph number locations, and any required approval. 
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When the Submittal Register is generated, SpecsIntact performs the following scans and places the 
information on a spreadsheet-like report for ease of locating all the Submittal Items throughout the 
Job: 
 

• Searches for the Submittal Article within PART 1 of each Section. 
• Locates all tagged Submittal Descriptions (SD-01 – SD-11) listed in each Section’s Submittal 

Article. 
• Locates the Submittal Items appearing below each SD# throughout the Sections.  
• Generates the Submittal Register and inserts the Subpart location for each Submittal Item in 

the Sections’ text (outside the Submittal Article). 
 

 
 

 The Submittal Register (REGISTER.PDF) does not appear in the SI Explorer’s Processed Files 
folder the way the other reports and lists do. It will, however, print when you click Process & 
Print. If you are publishing to PDF, it will appear in the PDF Files folder under the Job name 
folder in the SI Explorer. 

 

 Additional information on and generating the Submittal Register can be found under the 
Submittal Register topic in this guide.  
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Troubleshooting the Submittal Register 
 
Here are some examples of Submittal Register report problems and the cause of them: 
 

Problem Cause 
Column (f) Classification Government or A/E 
Reviewer has double G G 

The Submittal Item is listed twice in the 
Submittal Article under the same Submittal 
Description (SD). 

Column (e) Paragraph # is blank The Submittal Item is only found in the Submittal 
Article and is not used anywhere in the Section’s 
text. 

AE appears in Column (d) instead of Column (f).  Classification G must precede Reviewer as 
follows in the Section: <SUB>G AE</SUB> 

FIO appears in Column (d) instead of Column (f). FIO is no longer recognized on the UFGS 
Submittal Register and should not be used in 
the Submittal Article. 

 

 Additional information on valid Submittal Descriptions and Submittal Items can be found under 
the Tags and Submittals and Submittal Wizard topics in this guide. 

 

 To learn more about Classification and Reviewer codes, refer to the Submittal Formatting 
Guidelines topic in the Web-Based Help. 

 
 
The Submittal Register Output Options 
 
SpecsIntact offers three output options in addition to the SpecsIntact printed Submittal Register: 
output to a Web Format (.htm), a Comma Delimited Format (.txt) and to Microsoft Excel Format 
(.xlsx). These exported files are then placed in the Exported Files folder under the Job name: 
 

 All three Submittal Register output formats can be generated at the same time or 
separately, just by selecting those option(s) on the Export Submittal Register window 
shown below. 

 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=Submittals%2FSubmittalFormattingRequirements.htm&rhsearch=Submittal%20classification&rhhlterm=submittal%20submittals%20classification
https://www.wbdg.org/tools/specsintact/Help/index.htm#t=Submittals%2FSubmittalFormattingRequirements.htm&rhsearch=Submittal%20classification&rhhlterm=submittal%20submittals%20classification
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The exported files are placed in the Exported Files folder under the Job name: 
 

 
 
To attach these files to an email: 
 

1. Select file(s) you want to email. 
2. Right-click and select E-mail. 
3. SpecsIntact automatically opens a new email window and attaches the selected files to it. 

 

 Alternately, you can right-click on the Exported Files folder and select Open in Windows 
Explorer to access those files there. Then you can either ‘copy and paste’ or ‘drag and 
drop’ them into an email. 

 
 For additional guidance, watch the Submittal Wizard eLearning module within Chapter 3 – 

Editing. 
  

https://www.wbdg.org/dod/specsintact/elearning
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Job Checklist – Steps from Start to Finish 
 
Please see the following guidelines on a Job’s life cycle from start to finish. These checklist items have 
all been discussed in earlier topics in this guide but have been consolidated in the order in which to 
perform the recommended steps – prior to Job creation all the way to the final phase of the project. 
 

1. Make sure you have the most recent SpecsIntact software installed as well as the latest UFGS 
Master downloaded and connected. 

 

 Additional information on updating the SpecsIntact software and the UFGS Master can 
be found in the Installation Guide on our Support and Help Center webpage.  

 
2. Print the UFGS Master Table of Contents with Scope to PDF from and forward the file 

‘SCOPE.PDF’ file to the project engineer to decide which Sections they would like to include in 
the Job. You must generate this by selecting the UFGS folder in the SI Explorer and then 
clicking the Print/Publish button. 
 

 Additional information on generating and publishing the Project TOC can be found under 
the Pre-Job Checklist and Guidance Notes and Print Processing – Reports Tab/Table of 
Contents topics in this guide.  

 
3. Use marked up Master Table of Contents to then create the Job by adding the selected 

Sections. 
 

 Additional information on creating a Job can be found under the SpecsIntact Workflow - 
Creating and Publishing a Job topic in this guide.  

 
4. Once the Job is created and contains all the applicable Sections, run the Export Tailoring for 

Job function and provide this list to the engineer to pre-edit the list. 
 

 Additional information on exporting Tailoring Options can be found under the Pre-
Printing, Markup and Editing Considerations and Questions topic in this guide.  

 
5. Once you receive the marked up Tailoring Options report back from the engineer, Tailor the 

Job accordingly. 
 

 Additional information on pre-tailoring a Job can be found under the Using Tailoring 
Options to Pre-Edit a Job topic in this guide.  

 

https://www.wbdg.org/dod/specsintact/support-help-center
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6. Ask pre-editing questions prior to providing Sections for mark-up. 
 

 Additional information on pre-editing questions can be found under the Pre-Editing 
Questions topic in this guide.  

 
7. Print/Publish Job Sections to PDF or Word and send them to engineer(s) for initial markups. 

 

 Additional information on optimal print options for first time markup can be found 
under the Print Recommendations for Sections Prior to First Markups topic in this guide.  

 
8. Receive markups and edit Job Sections as cleanly as possible based on the tagging and editing 

rules defined in this guide. 
 

 Additional information on editing a Job can be found under the SI Editor - Editing Tips 
topic in this guide.  

 
9. Print/Publish all SpecsIntact reports to QA your edits and resolve any errors or discrepancies. 

 

 Additional information on processing and publishing SpecsIntact reports can be found 
under the Cleaning Up SpecsIntact Reports topic in this guide.  

 
10. Once you’ve fixed the report issues that you can handle on your own, re-publish your Sections 

as PDF or Word files. Send published Sections back for review and additional edits. Be sure to 
include any reports that require engineering attention and select the appropriate print options 
from the Print Processing window under the Options tab > Show section that are applicable 
for this phase of the Job (e.g., you may or may not need to continue publishing with Notes 
showing, etc.). 

 

 Additional information on publishing Job Sections can be found under the Understanding 
Process and Print/Publishing topic in this guide.  

 
11. When you receive the next round of markups, repeat steps 8 through 11 above again. 
 
12. Once the Job has been deemed FINAL, use the SpecsIntact Package Builder feature to compile 

a complete PDF file of your project for delivery. 
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SpecsIntact and UFGS Resources 
 
For any SpecsIntact Technical Support or assistance, please contact the SpecsIntact Help Desk either 
by phone or email. 
 
SI Technical Support 
 
For SpecsIntact technical software support, contact the team weekdays from 7:00 AM–3:30 PM 
Central Time: 

 
• Phone: 256.895.5505 
• Email: specsintact@usace.army.mil 

 
SI Website Resources 
 
Please see additional SpecsIntact webpage links and information: 
 

• Main SpecsIntact/WBDG Website: https://specsintact.wbdg.org 
 
Latest SpecsIntact Version Locations And Installation Information 

 
• Download Latest SpecsIntact Version: https://specsintact.wbdg.org/software/download 

 
o Army/USACE – Request from App Portal 
o Navy – Request from local IT Department (Software Center) 
o Air Force – Request from local IT Department 

 
• SI Lite – See Chapter 2 of SI Installation Guide: 

https://www.wbdg.org/tools/specsintact/InstallationGuide.pdf 
 

• SpecsIntact Support and Help Center: https://specsintact.wbdg.org/support-help-center 
 

On this page: 
 
o Link to Installation Guide: https://www.wbdg.org/tools/specsintact/InstallationGuide.pdf 
o Link to SpecsIntact (Searchable) Web-based Help: 

https://www.wbdg.org/tools/specsintact/Help/index.htm#t=Welcome.htm 
 

mailto:specsintact@usace.army.mil?Subject=SI%20Help%20Request
https://specsintact.wbdg.org/
https://specsintact.wbdg.org/software/download
https://www.wbdg.org/tools/specsintact/InstallationGuide.pdf
https://specsintact.wbdg.org/support-help-center
https://www.wbdg.org/tools/specsintact/InstallationGuide.pdf
https://www.wbdg.org/tools/specsintact/Help/index.htm#t=Welcome.htm
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• Submit a Software Change/Enhancement Request: Go to SI Explorer > Tools menu > Software 
Change Request > Create/Edit Form. Fill out the form in detail and provide contact 
information. 

 
UFGS Resources 
 

• UFGS Masters Website: https://www.wbdg.org/dod/specsintact/masters 
 

• UFGS Changes and Revisions: https://www.wbdg.org/dod/ufgs/ufgs-changes-revisions 
 

• Unified Master Reference List (UMRL): https://www.wbdg.org/FFC/DOD/UMRL/UMRL.pdf 
 

• CSI MasterFormat Section List: Contact your designated agency Dataset Manager for 
information on licensing for this manual: https://www.csiresources.org/home 

 
Additional UFGS Standard Guidelines and Documents: 
 

• UFS 1-300-02 (Unified Facilities Guide Specifications (UFGS) Format Standard): 
https://www.wbdg.org/dod/ufc/ufc-1-300-02 

 
• MIL-STD-3007G (Standard Practice Unified Facilities Criteria, Facilities Criteria and Unified 

Facilities Guide Specifications): https://www.wbdg.org/dod/fedmil/mil-std-3007 
 

• ER 1110-1-8155 USACE requirement at: ER 1110-1-8155.pdf (army.mil) (SpecsIntact is the 
Standard Specification Software System which is a DoD requirement for all Army, Navy, and Air 
Force construction specification projects.) 

 
eLearning Video Library 
 

Throughout this User Guide, you will find references to the applicable eLearning modules. Provided 
below is a link to the main eLearning website and the ‘eLearning_Library.PDF’ file that lists all the 
available eLearning modules. 
 

• SpecsIntact eLearning Videos: https://www.wbdg.org/dod/specsintact/elearning 
 

• SpecsIntact eLearning FULL Video Library List/TOC: 
https://www.wbdg.org/tools/specsintact/media/eLearning_Library.pdf 

https://www.wbdg.org/dod/specsintact/masters
https://www.wbdg.org/dod/ufgs/ufgs-changes-revisions
https://www.wbdg.org/FFC/DOD/UMRL/UMRL.pdf
https://www.csiresources.org/home
https://www.wbdg.org/dod/ufc/ufc-1-300-02
https://www.wbdg.org/dod/fedmil/mil-std-3007
https://www.publications.usace.army.mil/Portals/76/Publications/EngineerRegulations/ER_1110-1-8155.pdf
https://www.wbdg.org/dod/specsintact/elearning
https://www.wbdg.org/tools/specsintact/media/eLearning_Library.pdf
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